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Notice
The company reserves the right to revise this publication or to change its contents without notice. Information
contained herein is for reference only and does not constitute a commitment on the part of the manufacturer or
any subsequent vendor. They assume no responsibility or liability for any errors or inaccuracies that may appear
in this publication nor are they in anyway responsible for any loss or damage resulting from the use (or misuse)
of this publication.
This publication and any accompanying software may not, in whole or in part, be reproduced, translated, transmitted or reduced to any machine readable form without prior consent from the vendor, manufacturer or creators
of this publication, except for copies kept by the user for backup purposes.
Brand and product names mentioned in this publication may or may not be copyrights and/or registered trademarks of their respective companies. They are mentioned for identification purposes only and are not intended
as an endorsement of that product or its manufacturer.
©October 2013

Trademarks
Intel, Pentium and Intel Core are trademarks/registered trademarks of Intel Corporation.
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R&TTE Directive
This device is in compliance with the essential requirements and other relevant provisions of the R&TTE Directive 1999/5/EC.
This device will be sold in the following EEA countries: Austria, Italy, Belgium, Liechtenstein, Denmark, Luxembourg, Finland, Netherlands, France, Norway, Germany, Portugal, Greece, Spain, Iceland, Sweden, Ireland,
United Kingdom, Cyprus, Czech Republic, Estonia, Hungary, Latvia, Lithuania, Malta, Slovakia, Poland, Slovenia.

ErP Off Mode Power Consumption Statement:
The figures below note the power consumption of this computer in compliance with European Commission (EC)
regulations on power consumption in off mode:
• Off Mode
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< 0.5W
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CE Marking
This device has been tested to and conforms to the regulatory requirements of the European Union and has attained CE Marking. The CE Mark is a conformity marking consisting of the letters “CE”. The CE Mark applies
to products regulated by certain European health, safety and environmental protection legislation. The CE Mark
is obligatory for products it applies to: the manufacturer affixes the marking in order to be allowed to sell his
product in the European market.
This product conforms to the essential requirements of the R&TTE directive 1999/5/EC in order to attain CE
Marking. A notified body has determined that this device has properly demonstrated that the requirements of the
directive have been met and has issued a favorable certificate of expert opinion. As such the device will bear the
notified body number 0560 after the CE mark.
The CE Marking is not a quality mark. Foremost, it refers to the safety rather than to the quality of a product.
Secondly, CE Marking is mandatory for the product it applies to, whereas most quality markings are voluntary.
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FCC Statement
(Federal Communications Commission)
You are cautioned that changes or modifications not expressly approved by the party responsible for compliance
could void the user's authority to operate the equipment.
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part
15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in
a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications.
However, there is no guarantee that interference will not occur in a particular installation. If this equipment does
cause harmful interference to radio or television reception, which can be determined by turning the equipment
off and on, the user is encouraged to try to correct the interference by one or more of the following measures:
•
•
•
•

Re orient or relocate the receiving antenna.
Increase the separation between the equipment and receiver.
Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
Consult the service representative or an experienced radio/TV technician for help.

Operation is subject to the following two conditions:
1.

This device may not cause interference.
And

2.
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This device must accept any interference, including interference that may cause undesired operation of the
device.

Preface

FCC RF Radiation Exposure Statement:
1.

This Transmitter must not be co-located or operating in conjunction with any other antenna or transmitter.

2.

This equipment complies with FCC RF radiation exposure limits set forth for an uncontrolled environment. This
equipment should be installed and operated with a minimum distance of 20 centimeters between the radiator
and your body.


Warning
Use only shielded cables to connect I/O devices to this equipment. You are cautioned that changes or modifications not expressly approved by the manufacturer for compliance with the above standards could void your authority to operate the
equipment.
If your purchase option includes both Wireless LAN and 3G modules, then the appropriate antennas will be installed. Note
that In order to comply with FCC RF exposure compliance requirements, the antenna must not be co-located or operate in
conjunction with any other antenna or transmitter.
Important Notice - 3G & Bluetooth/Wireless LAN Modules
In order to comply with FCC regulations you should NOT operate the 3G module and the Bluetooth/Wireless LAN modules
at the same time as this may disrupt radio frequency, and cause interference. When the 3Gmodule is powered on, make sure
that the Bluetooth/Wireless LAN modules are powered off.
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IMPORTANT SAFETY INSTRUCTIONS
Follow basic safety precautions, including those listed below, to reduce the risk of fire, electric shock, and injury
to persons when using any electrical equipment:
1.
2.
3.
4.
5.

Do not use this product near water, for example near a bath tub, wash bowl, kitchen sink or laundry tub, in a wet
basement or near a swimming pool.
Avoid using this equipment with a telephone line (other than a cordless type) during an electrical storm. There
may be a remote risk of electrical shock from lightning.
Do not use the telephone to report a gas leak in the vicinity of the leak.
Use only the power cord and batteries indicated in this manual. Do not dispose of batteries in a fire. They may
explode. Check with local codes for possible special disposal instructions.
This product is intended to be supplied by a Listed Power Unit as follows:

• AC Input of 100 - 240V, 50 - 60Hz, DC Output of 19V, 3.42A (65 Watts) minimum AC/DC Adapter.
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Instructions for Care and Operation
The notebook computer is quite rugged, but it can be damaged. To prevent this, follow these suggestions:
1.

Don’t drop it, or expose it to shock. If the computer falls, the case and the components could be damaged.
Do not expose the computer
to any shock or vibration.

2.

Do not place it on an unstable
surface.

Do not place anything heavy
on the computer.

Keep it dry, and don’t overheat it. Keep the computer and power supply away from any kind of heating element. This is an electrical appliance. If water or any other liquid gets into it, the computer could be badly damaged.
Do not expose it to excessive
heat or direct sunlight.

Do not leave it in a place
where foreign matter or moisture may affect the system.

Don’t use or store the computer in a humid environment.

Do not place the computer on
any surface that will block the
Vents/Fan Intakes.
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3.

Avoid interference. Keep the computer away from high capacity transformers, electric motors, and other
strong magnetic fields. These can hinder proper performance and damage your data.

4.

Follow the proper working procedures for the computer. Shut the computer down properly and don’t forget
to save your work. Remember to periodically save your data as data may be lost if the battery is depleted.
Do not turn off the power
until you properly shut down
all programs.

5.

Do not turn off any peripheral
devices when the computer is
on.

Take care when using peripheral devices.
Use only approved brands of
peripherals.
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Do not disassemble the computer by yourself.

Unplug the power cord before
attaching peripheral devices.

Perform routine maintenance
on your computer.
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Power Safety
The computer has specific power requirements:
• Only use a power adapter approved for use with this computer.
• Your AC/DC adapter may be designed for international travel but it still requires a
steady, uninterrupted power supply. If you are unsure of your local power specifications,
consult your service representative or local power company.
• The power adapter may have either a 2-prong or a 3-prong grounded plug. The third
prong is an important safety feature; do not defeat its purpose. If you do not have access
to a compatible outlet, have a qualified electrician install one.
• When you want to unplug the power cord, be sure to disconnect it by the plug head, not
by its wire.
• Make sure the socket and any extension cord(s) you use can support the total current
load of all the connected devices.
• Before cleaning the computer, make sure it is disconnected from any external power
supplies (i.e. AC/DC adapter or car adapter).
Do not plug in the power
cord if you are wet.

Do not use the power cord if
it is broken.

Do not place heavy objects
on the power cord.


Power Safety
Warning
Before you undertake
any upgrade procedures, make sure that
you have turned off the
power, and disconnected all peripherals
and cables (including
telephone lines and
power cord).
You must also remove
your battery in order to
prevent
accidentally
turning the machine
on. Before removing
the battery disconnect
the
AC/DC
adapter from the
computer.
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Polymer Battery Precautions
Note the following information which is specific to polymer batteries only, and where applicable, this overrides
the general battery precaution information overleaf.
• Polymer batteries may experience a slight expansion or swelling, however this is part of the battery’s safety mechanism and is not a cause for concern.
• Use proper handling procedures when using polymer batteries. Do not use polymer batteries in high ambient temperature environments, and do not store unused batteries for extended periods.

See also the general battery precautionary information overleaf for further information.
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Battery Precautions
• Only use batteries designed for this computer. The wrong battery type may explode, leak or damage the computer.
• Do not remove any batteries from the computer while it is powered on.
• Do not continue to use a battery that has been dropped, or that appears damaged (e.g. bent or twisted) in any way. Even
if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may possibly
result in fire.
• If you do not use the battery for an extended period, then remove the battery from the computer for storage.
• Recharge the batteries using the notebook’s system. Incorrect recharging may make the battery explode.
• Do not try to repair a battery pack. Refer any battery pack repair or replacement to your service representative or qualified service personnel.
• Keep children away from, and promptly dispose of a damaged battery. Always dispose of batteries carefully. Batteries
may explode or leak if exposed to fire, or improperly handled or discarded.
• Keep the battery away from metal appliances.
• Affix tape to the battery contacts before disposing of the battery.
• Do not touch the battery contacts with your hands or metal objects.


Battery Disposal & Caution
The product that you have purchased contains a rechargeable battery. The battery is recyclable. At the end of its useful life,
under various state and local laws, it may be illegal to dispose of this battery into the municipal waste stream. Check with
your local solid waste officials for details in your area for recycling options or proper disposal.
Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type recommended by the
manufacturer. Discard used battery according to the manufacturer’s instructions.
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Cleaning
Do not apply cleaner directly to the computer; use a soft clean cloth.
Do not use volatile (petroleum distillates) or abrasive cleaners on any part of the computer.

Servicing
Do not attempt to service the computer yourself. Doing so may violate your warranty and expose you and the
computer to electric shock. Refer all servicing to authorized service personnel. Unplug the computer from the
power supply. Then refer servicing to qualified service personnel under any of the following conditions:
•
•
•
•
•

When the power cord or AC/DC adapter is damaged or frayed.
If the computer has been exposed to rain or other liquids.
If the computer does not work normally when you follow the operating instructions.
If the computer has been dropped or damaged (do not touch the poisonous liquid if the LCD panel breaks).
If there is an unusual odor, heat or smoke coming from your computer.


Removal Warning
When removing any cover(s) and screw(s) for the purposes of device upgrade, remember to replace the cover(s) and
screw(s) before restoring power to the system.
Also note the following when the cover is removed:
•
•
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Hazardous moving parts.
Keep away from moving fan blades.
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Travel Considerations
Packing
As you get ready for your trip, run through this list to make sure the system is ready to go:
1.
2.
3.
4.
5.
6.
7.
8.

Check that the battery pack and any spares are fully charged.
Power off the computer and peripherals.
Close the display panel and make sure it’s latched.
Disconnect the AC/DC adapter and cables. Stow them in the carrying bag.
The AC/DC adapter uses voltages from 100 to 240 volts so you won’t need a second voltage adapter. However,
check with your travel agent to see if you need any socket adapters.
Put the notebook in its carrying bag and secure it with the bag’s straps.
If you’re taking any peripherals (e.g. a printer, mouse or digital camera), pack them and those devices’ adapters
and/or cables.
Anticipate customs - Some jurisdictions may have import restrictions or require proof of ownership for both hardware and software. Make sure your documents are prepared.


Power Off Before Traveling
Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container). Putting a
notebook which is powered on in a travel bag may cause the vent(s)/fan intake(s)/outlet(s) to be blocked. To prevent your
computer from overheating make sure nothing blocks the vent(s)/fan intake(s)/outlet(s) while the computer is in use.
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On the Road
In addition to the general safety and maintenance suggestions in this preface, and Chapter 8: Troubleshooting,
keep these points in mind:
Hand-carry the notebook - For security, don’t let it out of your sight. In some areas, computer theft is very
common. Don’t check it with normal luggage. Baggage handlers may not be sufficiently careful. Avoid knocking the computer against hard objects.
Beware of Electromagnetic fields - Devices such as metal detectors & X-ray machines can damage the computer, hard disk, floppy disks, and other media. They may also destroy any stored data - Pass your computer and
disks around the devices. Ask security officials to hand-inspect them (you may be asked to turn it on). Note:
Some airports also scan luggage with these devices.
Fly safely - Most airlines have regulations about the use of computers and other electronic devices in flight.
These restrictions are for your safety, follow them. If you stow the notebook in an overhead compartment, make
sure it’s secure. Contents may shift and/or fall out when the compartment is opened.
Get power where you can - If an electrical outlet is available, use the AC/DC adapter and keep your battery(ies)
charged.
Keep it dry - If you move quickly from a cold to a warm location, water vapor can condense inside the computer.
Wait a few minutes before turning it on so that any moisture can evaporate.
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Developing Good Work Habits
Developing good work habits is important if you need to work in front of the computer for long periods of time.
Improper work habits can result in discomfort or serious injury from repetitive strain to your hands, wrists or
other joints. The following are some tips to reduce the strain:
• Adjust the height of the chair and/or desk so that the keyboard is at or slightly below the level
of your elbow. Keep your forearms, wrists, and hands in a relaxed position.
• Your knees should be slightly higher than your hips. Place your feet flat on the floor or on a
footrest if necessary.
• Use a chair with a back and adjust it to support your lower back comfortably.
• Sit straight so that your knees, hips and elbows form approximately 90-degree angles when
you are working.
• Take periodic breaks if you are using the computer for long periods of time.
Remember to:
• Alter your posture frequently.
• Stretch and exercise your body several times a day.
• Take periodic breaks when you work at the computer for long periods of time. Frequent and
short breaks are better than fewer and longer breaks.
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Lighting
Proper lighting and comfortable display viewing angle can reduce eye strain and muscle fatigue in your neck and
shoulders.
•
•
•
•

Position the display to avoid glare or reflections from overhead lighting or outside sources of light.
Keep the display screen clean and set the brightness and contrast to levels that allow you to see the screen clearly.
Position the display directly in front of you at a comfortable viewing distance.
Adjust the display-viewing angle to find the best position.

LCD Screen Care
To prevent image persistence on LCD monitors (caused by the continuous display of graphics on the screen for
an extended period of time) take the following precautions:
•
•
•
•

Set the Windows Power Plans to turn the screen off after a few minutes of screen idle time.
Use a rotating, moving or blank screen saver (this prevents an image from being displayed too long).
Rotate desktop background images every few days.
Turn the monitor off when the system is not in use.

LCD Electro-Plated Logos
Note that in computers featuring a raised LCD electro-plated logo, the logo is covered by a protective adhesive.
Due to general wear and tear, this adhesive may deteriorate over time and the exposed logo may develop sharp
edges. Be careful when handling the computer in this case, and avoid touching the raised LCD electro-plated
logo. Avoid placing any other items in the carrying bag which may rub against the top of the computer during
transport. If any such wear and tear develops contact your distributor/supplier.
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Quick Start Guide

Chapter 1: Quick Start Guide
Overview
This Quick Start Guide is a brief introduction to the basic features of your computer, to navigating around the
computer and to getting your system started. The remainder of the manual covers the following:
• Chapter 2
• Chapter 3
• Chapter 4
• Chapter 5
• Chapter 6

• Chapter 7
• Appendix A
• Appendix B
• Appendix C
• Appendix D

A guide to using some of the main features of the computer e.g. the storage devices (hard disk,
optical device, card reader), Touchpad/Mouse and Audio.
The computer’s power saving options.
The installation of the drivers and utilities essential to the operation or improvement of some of the
computer’s subsystems.
An outline of the computer’s built-in software or BIOS (Basic Input Output System).
A quick guide to the computer’s PC Camera, Wireless LAN, Bluetooth & WLAN Combo, Intel
Technology and 3G modules (some of which may be optional depending on your purchase configuration).
A troubleshooting guide.
Definitions of the interface, ports/jacks which allow your computer to communicate with external
devices.
Information on Control Center.
Information on the video driver controls.
The computer’s specification.
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Advanced Users
If you are an advanced user you may skip over most of this Quick Start Guide. However you may find it useful
to refer to “What to Install” on page 4 - 1, “BIOS Utilities” on page 5 - 1 and “Upgrading The Computer” on
page 6 - 1 in the reminder of the User’s Manual. You may also find the notes marked with a  of interest to you.

Beginners and Not-So-Advanced Users

Notes
Check the light colored
boxes with the mark
above to find detailed information about the computer’s features.

If you are new to computers (or do not have an advanced knowledge of them) then
the information contained in the Quick Start Guide should be enough to get you up
and running. Eventually you should try to look through all the documentation (more
detailed descriptions of the functions, setup and system controls are covered in the
remainder of the User’s Manual), but do not worry if you do not understand everything the first time. Keep this manual nearby and refer to it to learn as you go. You
may find it useful to refer to the notes marked with a  as indicated in the margin.
For a more detailed description of any of the interface ports and jacks see “Interface
(Ports & Jacks)” on page A - 1.

Warning Boxes
No matter what your level please pay careful attention to the warning and safety information indicated by the
 symbol. Also please note the safety and handling instructions as indicated in the Preface.

1 - 2 Overview
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Not Included
Operating Systems (e.g. Windows 8) and applications (e.g. word processing, spreadsheet and database programs) have their own manuals, so please consult the appropriate manuals.


Drivers
If you are installing new system software, or are re-configuring your computer for a different system, you will need to install
the drivers listed in “Drivers & Utilities” on page 4 - 1. Drivers are programs which act as an interface between the computer and a hardware component e.g. a wireless network module. It is very important that you install the drivers in the order
listed. You will be unable to use most advanced controls until the necessary drivers and utilities are properly installed. If
your system hasn’t been properly configured (your service representative may have already done that for you); refer to
Chapter 4 for installation instructions.

Ports and Jacks
See “Notebook Ports and Jacks” on page A - 2 for a description of the interface (ports & jacks) which allow your computer to communicate with external devices, connect to the internet etc.

Overview 1 - 3
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System Startup
1.
2.
3.
4.
5.

Remove all packing materials.
Place the computer on a stable surface.
Securely attach any peripherals you want to use with the notebook (e.g. keyboard and mouse) to their ports.
Attach the AC/DC adapter to the DC-In jack on the right of the computer, then plug the AC power cord into an
outlet, and connect the AC power cord to the AC/DC adapter.
Use one hand to raise the lid/LCD to a comfortable viewing angle (do not exceed 127 degrees); use the other
hand to support the base of the computer (Note: Never lift the computer by the lid/LCD).

127°


Shutdown
Note that you should always
shut your computer down by
choosing the Shut Down
command in Windows (see
page 1 - 37). This will help
prevent hard disk or system
problems.

Figure 1 - 1 - Opening the Lid/LCD & Computer with AC/DC Adapter Plugged-In

1 - 4 System Startup
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System Software
Your computer may already come with system software pre-installed. Where this is not the case, or where you
are re-configuring your computer for a different system, you will find the Windows 8.1 operating system is supported.
Note: In order to run Windows without limitations or decreased performance, your computer requires a minimum 1GB of system memory (RAM).


Windows Versions
Note that the information included on the following pages is for Windows 8.1 only.
The Windows 8 interface is slightly different in appearance and in methods of navigation, and a separate manual is provided on the Device Drivers & Manual Disc for Windows 8.

Windows OS
In order to run Windows 8/8.1 (32 Bit) without limitations or decreased performance, your computer requires a minimum
1GB of system memory (RAM), however if you are running Windows 8/8.1 (64 bit) your computer requires a minimum
2GB of system memory (RAM).

System Startup 1 - 5
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Model Differences
This notebook series includes three different model types that mainly differ as indicated in the table below. Note that
your model may appear slightly different from those pictured in this manual.
Feature

Model A

Model B

Model C

Video Adapter

Intel HD Graphics (GPU is Dependent
on Processor)

Intel HD Graphics with NVIDIA®
Optimus Technology (GPU switchable
between iGPU & dGPU)
NVIDIA® GeForce 745M

Intel HD Graphics (GPU is Dependent
on Processor)

Sound Blaster™
Cinema Audio

Not Supported

Supported

Not Supported

Wireless
Communication
Options
Multi Touch
Screen

See “Communication” on page D - 3 for details of WLAN modules supported by each model.

Not Supported

Dimensions &
Weight

Not Supported

340mm (w) * 240mm (d) * 21mm (h)
2.0kg with ODD and Battery
See Appendix D for detailed specification.

Table 1 - 1 - Model Differences

1 - 6 Model Differences

Supported
340mm (w) * 240mm (d) * 22.8mm (h)
2.0kg with ODD and Battery
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System Map: LCD Panel Open
2

1

3


Wireless Device
Operation Aboard
Aircraft

4

5
6

Figure 1 - 2
LCD Panel Open

The use of any portable electronic transmission devices
aboard aircraft is usually prohibited. Make sure the WLAN/
Bluetooth module(s) are OFF
if you are using the computer
aboard aircraft.

1.
2.
3.
4.
5.
6.
7.

Built-in PC Camera
PC Camera LED
Built-In Microphone
LCD
Power Button
Keyboard
Touchpad &
Buttons

Use Fn + F11 Airplane Mode
key combination to toggle Airplane Mode On/Off, and
check the LED indicator for
the power status (see Table 1
- 4, on page 1 - 11/ Table 1 2, on page 1 - 8).

7

System Map: LCD Panel Open 1 - 7
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LED Indicators
The LED indicators on the computer display helpful information about the current status of the computer.
Icon

Color

Description

Orange

DC Power is Plugged In

Green

The Computer is On

Blinking Green

The Computer is in Sleep Mode

Orange

The Battery is Charging

Green

The Battery is Fully Charged

Blinking Orange

The Battery has Reached Critically Low Power Status

Green

Airplane Mode is ON (the WLAN, Bluetooth & 3G Modules are
OFF)

Green

Hard Disk Activity

Table 1 - 2 - LED Power Indicators

1 - 8 LED Indicators
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Keyboard
The keyboard has an embedded numerical keypad for easy numeric data input, and
function keys to change operational features instantly.
Function Keys
NumLk &
ScrLk Keys

Play/Pause Key
Numerical
Keypad

Fn Key

Menu/Application Key


Other Keyboards
If your keyboard is damaged or you just want to
make a change, you can
use any standard USB
keyboard. The system will
detect and enable it automatically. However special
functions/hot-keys
unique to the system’s
regular keyboard may not
work.

NumLk & ScrLk
Windows Logo Key

Figure 1 - 3 - Keyboard


Special Characters

Hold down the Fn Key
and either NumLk or
ScrLk to enable number
or scroll lock, and check
the LED indicator for status.

Some software applications allow the number-keys to be used with Alt to produce special characters.
These special characters can only be produced by using the numeric keypad. Regular number keys (in
the upper row of the keyboard) will not work. Make sure that NumLk is on.

Keyboard 1 - 9
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Windows Logo
Keyboard Shortcut
Use the Windows logo
key
+ D key combination to switch between the Start screen
and Windows Desktop.

Menu/Application
Keyboard Shortcut
When the Desktop app
is running you can use
the Menu/Application
key
on the keyboard to display the
context menu as per a
mouse right-click. In
the Start screen this
function is useful to
quickly display the All
Apps icon.

Keyboard Shortcuts
The following Windows Logo Key (Winkey) keyboard shortcuts are useful for navigation/operation in Windows 8.1.
Windows Logo
Key +

Description

Tap Winkey

Toggle between the Start screen and the foremost running app or the
Windows Desktop

C

Display Charms menu

D

Switch to the Windows Desktop and toggle show Desktop

E

Switch to the Windows desktop and launch Windows Explorer with
Computer displayed

F

Display file Search

I

Open the Settings charm

K

Open the Connect charm

L

Lock the computer and display the Lock screen

P

Display the Second Screen menu (see Figure 1 - 25 on page 1 - 32)

R

Switch to the Windows Desktop and display the Run dialog box

Z

Access the Customize Bar (see Figure 1 - 16 on page 1 - 24)

Table 1 - 3 - Keyboard Shortcuts
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Quick Start Guide

Function/Hot Key Indicators
The function keys (F1 - F12 etc.) will act as hot keys when pressed while the Fn key is held down. In addition
to the basic function key combinations; visual indicators are available when the hot key utility is installed.
Keys
Fn +

Fn +

Function
Play/Pause (in Audio/Video Programs)

TouchPad Toggle

Fn +

Turn LCD Backlight Off
(Press a key to or use TouchPad to turn on)

Fn +

Mute Toggle

Fn +

Sleep Toggle

Fn +

Fn +

Keys
Fn +

Brightness Decrease/Increase

Fn +

PC Camera Power
Toggle

Fn +

Airplane Mode Toggle

Fn +

Fn +

Volume Decrease/Increase

Display Toggle

Function

Number Lock Toggle

Scroll Lock Toggle

Caps Lock Toggle

Fn +

Fan Control Toggle
- Automatic Fan
Control / Full Power

Table 1 - 4 - Function & Hot Key Indicators

Function/Hot Key Indicators 1 - 11
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Control Center
When in the Windows Desktop application (not in the Start screen) press the Fn + Esc key combination, or
double-click the icon in the notification area of the taskbar to toggle the Control Center on/off. The Control Center gives quick access to frequently used controls and enables you to quickly turn the camera/Touch
Pad on/off.


Control Center
Click on any button to turn any of the modules (e.g.
TouchPad, Camera) on/off.
Click on the power conservation modes to switch between Performance, Balanced or Energy Star modes.
To remove the Power Conservation Modes screen
just click in a blank area of the icon or press a key on
the keyboard.
Click on the buttons (or just click and hold the mouse
button) to adjust the slider for Brightness/Volume.
Click on Display Switch and click to choose a display
mode from the menu.

Figure 1 - 4 - Control Center

1 - 12 Control Center
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System Map: Front & Left Views

Figure 1 - 5
Front & Left Views
1.

1
2.
3.

2

3

4

5

6

4.



5.

Overheating

6.

LED Power
Indicators
Security Lock Slot
Microphone-In
Jack
Headphone-Out
Jack
Vent/Fan Intake/
Outlet
Speaker

To prevent your computer from overheating make sure nothing blocks the Vent/Fan Intake
while the computer is in use.

System Map: Front & Left Views 1 - 13
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Figure 1 - 6
Right & Rear Views
1. Speaker
2. Multi-in-1 PushPush Card
Reader
3. USB 3.0 Port
4. HDMI-Out Port
5. RJ-45 LAN Jack
6. DC-In Jack
7. Battery


Overheating
To prevent your computer from overheating
make
sure
nothing
blocks the Vent/Fan Intake while the computer
is in use.

System Map: Right & Rear Views
1

3

2
7


Multi-In-1 Push-Push Card
Reader
The card reader allows you to use the
most popular digital storage card formats:
MMC (MultiMedia Card) / RS MMC
SD (Secure Digital) / Mini SD / SDHC /W255EU
SDXC

Optical Device Drives
To install applications and drivers etc.
you will need to attach an external optical CD/DVD device to the USB ports.

1 - 14 System Map: Right & Rear Views
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System Map: Bottom View
1


4

2

Battery Information

2
2

3

5

2

3

Always completely discharge,
then
fully
charge, a new battery
before using it. Completely discharge and
charge the battery at
least once every 30
days or after about 20
partial discharges.

Figure 1 - 7
Bottom View
1.
2.
3.
4.
5.

Battery
Vent/Fan Intake/
Outlet
Speakers
Component Bay
Cover
HDD Bay Cover


CPU
The CPU is not a user
serviceable part.



3G USIM Card
Installation

Overheating
To prevent your computer from overheating make sure nothing blocks the Vent/Fan Intake
while the computer is in use.

If your model includes the
3G option then remove
the battery to access the
USIM card slot.

System Map: Bottom View 1 - 15
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Power Safety
Warning
Before you undertake any
installation
procedures,
make sure that you have
turned off the power, and
disconnected all peripherals and cables (including
telephone lines). It is advisable to also remove your
battery in order to prevent
accidentally turning the machine on.

USIM Card Orientation

3G Module USIM Card Installation
If you have included an optional 3G module, follow the instructions below to install
the USIM card (which will be provided by your service provider). See page 7 - 64
for configuration instructions.
1.Turn the computer off, remove the AC/DC adapter and turn it over.
2.Slide the latch 1 in the direction of the arrow.
3.Slide the latch 2 in the direction of the arrow, and hold it in place.
4.Grip the battery and remove it in the direction of arrow 3 .
5.Insert the USIM card 4 (at the rear of the battery compartment) as illustrated below,
until it clicks fully into position.
6.When reinserting the battery slide it in to the battery bay as illustrated 5 .

1

2

3

Note that the USIM card’s
readable side (with the
gold-colored
contacts)
should face upwards as illustrated.

4
Figure 1 - 8
Battery Removal &
USIM Card Insertion

5

1 - 16 3G Module USIM Card Installation
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Windows 8 Touch Screen Controls/Gestures
(For Model C Touch Screens Only)
Model C computers incorporate a touch screen, and this can be used to navigate through the interface in much
the same way as a mouse, touchpad and keyboard. Where you see the instruction to click an item in this manual, you can choose to tap/double tap the appropriate area of the screen instead. The following gestures are
useful when navigating the Windows 8 interface.

• Swipe from the right (Access the Charms Bar) - Pull your finger from the right side of the screen (in the
black area) to the left a little bit to bring up the Charms Bar.

Figure 1 - 9 - Swipe from Right & Left

• Swipe from the left (Switch apps) - If multiple apps are running you can slide your finger from the left side
of the screen (in the black area) to the right to switch between apps.
• Swipe slowly from the left (Snap apps) - Perform the same action above more slowly, to drag one app out
and display it side-by-side with the app that was already on your screen.

Windows 8 Touch Screen Controls/Gestures 1 - 17
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• Swipe from left and back (Display running apps) - Slide your finger from the left and quickly drag it back
towards the right to display a list of apps that are currently running. Tap any app to switch to it.
• Pull down from the top (Close app) - Close any running app by starting at the top area of the screen and
quickly pulling your finger about halfway down the screen.
• Swipe down/up (All Apps menu) - Swiping the finger a little bit down from the top, or up from the bottom
of the Start screen will bring up the menu with the All Apps icon. Tap the All Apps icon to access the apps.

Figure 1 - 10 - Swipe Up and Tap, Hold & Release (Desktop Right-Click)

• Swipe down on an item (Select/right-click) - Swipe down on any tile in the Start screen to select it and
bring up additional options.
• Tap, Hold & Release (Desktop right-click) - Tap the Desktop, hold until a square icon appears, and then
release to access the right click menu.

1 - 18 Windows 8 Touch Screen Controls/Gestures
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Touch Keyboard
(For Model C Touch Screens Only)
If you need to type on screen then the Touch Keyboard will pop up when required (e.g. when you need to type
in an internet URL address in Internet Explorer). When the Touch Keyboard is displayed you have several display/input options and these can be accessed from the icon
at the bottom right of the
keyboard. To access the Touch Keyboard from the Desktop app click/tap the keyboard icon in the taskbar
.
Touch Keyboard Desktop app taskbar Icon

Select Keyboard or Writing Pad Input
Figure 1 - 11 - Touch Keyboard

Touch Keyboard 1 - 19
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The Touch Keyboard allows you to input text without the use of an actual keyboard., and you can use writing
pad to write (continuously or one character at a time) or touch keyboard to input text. Use the Help menu for
further information.

Click Help

Figure 1 - 12 - Touch Keyboard, Writing Pad Input & Help

1 - 20 Touch Keyboard
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Windows 8.1 Control Panel
Throughout this manual you will see an instruction to open the Control Panel.
Right-click the lower left hot corner to bring up the context menu (or use the Windows Logo Key
+ X key combination) and select Control Panel in both the
Desktop app or Start screen.

Desktop app


Windows Versions
Note that the information included on the following pages is for
Windows 8.1 only.
The Windows 8 interface is slightly different
in appearance and in
methods of navigation,
and a separate manual
is provided on the Device Drivers & Manual
Disc with reference to
Windows 8.

Start Screen

Move the mouse to the bottom left
of the screen and right-click to
access the menu.
Figure 1 - 13 - Windows Context Menu

Windows 8.1 Control Panel 1 - 21
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Display Most
Recently Used
Apps

Right-click the Start button in the Desktop app (or use the Windows Logo Key
+ X key combination) to bring up an advanced context menu of useful features
such as Control Panel, Programs and Features, Power Options, Task Manager,
Search, File Explorer, Command Prompt, Device Manager and Network Connections etc.

If you are in the Start
screen, Desktop or an
app you can move your
mouse to the upper left
corner of the screen to
get back to the most recently used app.
To view all the most recently used Apps hover
over the top left of the
screen and then move
the mouse down along
the left side of the
screen to display the
list.

Move the mouse to the bottom left of the screen
and right-click the Start button to access the menu.
Figure 1 - 14 - Advanced Context Menu (Right-Click Start Button)

1 - 22 Windows 8.1 Control Panel
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Windows 8.1 Start Screen & Desktop
The Apps, control panels, utilities and programs within Windows are accessed from the Start screen and/or
Windows Desktop app. The Desktop (which runs as an app within the Start screen) can be accessed by clicking
the Desktop item in the Start screen (or by using the Windows Logo Key
+ D key combination). Click the
arrow at the bottom of the Start screen to access Apps.

Desktop App
Figure 1 - 15 - Windows Start Screen

Windows 8.1 Start Screen & Desktop 1 - 23
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Apps & Tiles
The Start screen will contain a number of apps, and many more will be installed as you add more applications
etc. Not all of these apps can fit on one screen so you will often need use the slider at the bottom of the screen
in order to view all the necessary Apps.
Accessing Pining/Unpinning All Apps
You can add and remove the tiles for apps and control panels in the Start screen. Right-click on a blank area
of the Start screen, and you will see the Customize icon. Click the Customize icon to display all the installed
applications etc. Right-click any icon to bring up the menu at the bottom of the screen and you can then click the
appropriate icon to pin the App to (or unpin from) the Start screen, or to the taskbar in the Desktop application (you can also open the app in a new window, run as administrator or open the file location).
Click the arrow at the bottom of the
screen to access All Apps

Figure 1 - 16 - Customize Apps
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Desktop Application
When the Desktop app is running (click the app in the Start screen or use the Windows Logo Key
+ D key
combination) you can use lower left hot corner to switch between the Start screen and the Windows Desktop
app. To do so move your mouse to hover over the bottom left corner of the Desktop app and left-click.
When you move to the lower left hot corner in the Start screen it will take you back to your most recently used
app (if one is running).

Move the mouse to the bottom left of the screen and click to switch
back to the Start screen.
Figure 1 - 17 - Desktop

Windows 8.1 Start Screen & Desktop 1 - 25
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The Charms Bar
The right side of the screen displays the Charms Bar. The Charms Bar contains the Search, Share, Start, Devices and Settings menus. To access up the Charms Bar move the cursor to the upper or lower right corners of
the screen, and then hover over one of the items in the Charms Bar to activate it (the bar will be black when it
is active), or use the Windows Logo Key
+ C key combination.
Move the mouse to the top/lower right icons to activate the Charms Bar
Move the mouse over a Charms Bar icon to activate the menu

Move the mouse to the top/lower right icons to activate the Charms Bar
Figure 1 - 18 - Start Screen with Charms Bar
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Charms Bar Items

• Search
results.
• Share

: You can search for any file, application, Apps and control panel settings with instantaneous
: This button is used to share information with people via mail or social networks.

• Start
: Click to bring up the Start screen (the same function as pressing the Windows Logo Key or clicking the bottom left of the screen).
• Devices

: Click this button to change connected peripheral device settings e.g. an external display.

• Settings
: This button gives instant access to the computer settings, such as Network, Audio, Notifications, Power and Keyboard (click Change PC Settings to activate the PC Settings menu).


Charms Bar - TouchPad Access
To quick access the Charms Bar using the TouchPad:

1.
2.
3.

Place your finger off the TouchPad (slightly to the right of the
pad resting on the computer).
Move your finger across to the left on to the TouchPad.
The Charms Bar will then pop-up.

Figure 1 - 19 - Settings Menu

Windows 8.1 Start Screen & Desktop 1 - 27
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Windows 8.1 Control Panel
In many instances throughout this manual you will see an instruction to open the Control Panel. The Control
Panel can be accessed in a number of ways in Windows 8.1.

• Click Search in the Windows Charms Bar (see previous page) and the search pane will pop out. Type
Control Panel and select it from the results to the left.

Figure 1 - 20 - Search (Control Panel)

• Click on This PC (in Apps, or you can to pin This PC to the Start screen), click on Computer in the
top menu and select Open Control Panel from the ribbon.

Figure 1 - 21 - Open Control Panel (Computer)
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• When in the Desktop app (this does not apply to the Start screen) click on Settings in the Windows
Charms Bar and select Control Panel from the menu.

Figure 1 - 22 - Settings Charms Bar (Desktop App Only)

• Click the arrow at the bottom of the Start screen and click Control Panel in Apps (Windows System).

Figure 1 - 23 - All Apps - Control Panel

Windows 8.1 Control Panel 1 - 29
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• Right-click the Start button to bring up the menu and select Control Panel (see Figure 1 - 14 on page 1
- 22).


Keyboard Shortcut to Control Panel
You can also use keyboard shortcuts to access the Control Panel. Press the Windows logo key
and X to bring up
the context menu, and then press P to bring up the Control Panel. Alternatively press the Windows logo key
and R
to bring up the Run dialog box, and then type “Control Panel” and press Enter to access the Control Panel.

1 - 30 Windows 8.1 Control Panel
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Windows 8.1 Taskbar
In many instances throughout this manual you will see an instruction to access the notification area of the taskbar (system tray). In Windows 8.1 the taskbar is accessed from the Desktop application; if you are in the Start
screen you will need to switch to the Desktop.
The taskbar is displayed at the bottom of the Desktop screen, and you can see the notification area (system
tray) of the taskbar in the bottom right of the screen. Some of the control panels and applications referred to
during the course of this manual can be accessed from here.

Figure 1 - 24 - Desktop Taskbar & Notification Area (System Tray)

You can pin/unpin apps to/from the taskbar in much the same way as you can to the Start screen (see “Accessing
Pining/Unpinning All Apps” on page 1 - 24).

Windows 8.1 Control Panel 1 - 31
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Video Features
You can switch display devices, and configure display options, from the Display control panel (in Appearances
and Personalization) in Windows when running the Desktop app (see “Desktop Application” on page 1 - 25).
It is possible to quickly configure external displays from the Devices menu item in the Charms Bar (see “The
Charms Bar” on page 1 - 26).
To Configure Displays from Devices (Charms Bar):
1.
2.
3.
4.

Attach your display to the appropriate port, and turn it on.
Go the Charms Bar, select Devices.
Click Project (you may need to click Second Screen).
Click on any one of the options from the menu to select PC screen only, Duplicate, Extend or Second screen
only.

Figure 1 - 25 - Devices (Project)
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NVIDIA® Optimus™ Technology
(Model B Only)
NVIDIA® Optimus™ Technology is a seamless technology (supported by Model B only) designed to get best
performance from the graphics system while allowing longer battery life, without having to manually change
settings. The computer will automatically switch between the integrated UMA (Unified Memory Architecture)
GPU (iGPU) and the discrete GPU (dGPU) when required by the applications in use.

In this computer series Model B supports both the Intel(R) HD Graphics control panel and the NVIDIA control
panel, however Models A & C (which do not support NVIDIA® Optimus™ Technology) only support the Intel(R) HD Graphics control panel.

Video Features 1 - 33
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To access Display (Control Panel) and Screen Resolution in Windows 8:
1.
2.
3.

Go to the Control Panel.
Click Display (icon) - In the Appearance and Personalization category.
Adjust resolution.


Right-Click Desktop App
1.

2.

2
1
3

Figure 1 - 26 - Screen Resolution

1 - 34 Video Features

3.

You can right-click the
desktop and select
Screen resolution
1 (Figure 1 - 26).
Use the dropbox to
select the screen
Resolution 2
(Figure 1 - 26).
Click Advanced
settings 3 (Figure
1 - 26) to bring up the
Advanced properties
tabs.
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To access the Intel(R) HD Graphics Control Panel:
1.
2.

Click Advanced settings 3 (Figure 1 - 26 on page 1 - 34) in the Screen Resolution control panel in Windows.
Click the Intel(R)... tab and click Graphics Properties (button) 4 (Figure 1 - 27) .

OR
3.

Right-click the desktop and select Graphics Properties from the menu.

OR
4.

Click the icon

in the notification area of the Desktop taskbar and select Graphics Properties from the menu.

4

Figure 1 - 27 - Intel Graphics Control Panel
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To access the NVIDIA Control Panel (for Model B only):
1.

Right-click the desktop and select NVIDIA Control Panel 5 (Figure 1 - 28).

OR
2.

Double-click the icon

6 (Figure 1 - 28) in the Windows control panel.

5

6

Figure 1 - 28 - NVIDIA Control Panel
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Power Options
Power Options (Hardware and Sound) can be accessed from the Control Panel. The Power Menu item in Settings in the Charms Bar in Windows 8.1 may be used to Shut down or Restart (you can also add Hibernate/
Sleep to the menu - see “Adding Hibernate/Sleep to the Power Menu” on page 3 - 10). You can also use the
context menu (Shut down or sign out) shut the computer down/restart etc.
Shut Down, Restart or Sleep (Charms Bar)
1.
2.
3.

Go to the Charms Bar and click Settings.
Click Power
.
Select Sleep, Shut Down or Restart.
Charms Bar

Desktop App

Start Screen

Figure 1 - 29 - Shut Down/Restart
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Running Apps
To run apps in Windows 8.1 you will need to check that the Screen Resolution and User Account Control Settings are compatible with the system requirements.
Screen Resolution Settings
1.
2.

Switch to the Windows Desktop (click the app or use the Windows logo key
+ D key combination).
Right-click a blank area of the Windows Desktop and select Screen Resolution. Adjust the Resolution to
make sure that it is at least 1024 * 768, although preferably 1366 * 768 or above (see sidebar).


Screen Resolution for Apps
(Windows 8/8.1)
The minimum resolution in which Apps will run is 1024x768.
The minimum resolution required to support all the features of
Windows 8 (including multitasking with snap) is 1366x768.
These specs are the minimum screen resolution that supports
all the features of Windows 8.1 on a useful physical size.

Figure 1 - 30 - Screen Resolution
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User Account Control Settings
If your computer meets the minimum screen resolution requirements, and still you can't run apps, then that you
have to check the status of User Account Control (UAC). Apps may fail to open when the UAC is turned off.
To check whether the UAC is on or off, follow the instructions below.
1.
2.
3.
4.

Open the Control Panel.
Click on User Accounts and then click on Change User Account Control settings (or click System and
Security and click Change User Account Control Settings under Action Center).
If the slider is in the Never notify position, then the UAC is disabled.
To enable or turn on the UAC, move the slider to Always notify or Notify me when apps try to make changes
to my computer (default) position, and then click OK.

Figure 1 - 31 - User Account Control
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Chapter 2: Features & Components

2

Overview
Read this chapter to learn more about the following main features and components
of the computer:
•
•
•
•

Hard Disk Drive/Solid State Drive
Multi-In-1 Push-Push Card Reader
Touchpad and Buttons/Mouse
Audio Features

Overview 2 - 1
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Power Safety
Before attempting to access any of the internal
components of your
computer please ensure
that the machine is not
connected to the AC
power, and that the machine is turned off. Also
ensure that all peripheral cables, including
phone lines, are disconnected from the computer.

Hard Disk Drive/Solid State Drive
The hard disk/solid state drive is used to store your data in the computer. The HDD/
SSD can be taken out to accommodate other serial (SATA) drives (see “Storage”
on page D - 2 for specification information) The hard disk is(are) accessible after
removing the hard disk bay or component bay cover from the bottom of your computer as seen below.
Further details on removing and inserting the hard disk are available in “Upgrading
the Hard/Solid State Disk Drive” on page 6 - 6.

Component Bay Cover (for SSD)
Hard Disk Bay Cover

Figure 2 - 1
Hard Disk/SSD
Location


Warranty Warning
Please check with your service representative before undertaking any upgrade procedures to find out
if this will VOID your warranty.

2 - 2 Hard Disk Drive/Solid State Drive
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Multi-In-1 Push-Push Card Reader
The card reader allows you to use some of the latest digital storage cards. Push the
card into the slot and it will appear as a removable device, and can be accessed in
the same way as your hard disk (s). Make sure you install the card reader driver (see
“CardReader” on page 4 - 7.
• MMC (MultiMedia Card) / RS MMC
• SD (Secure Digital) / Mini SD / SDHC / SDXC
Note: Some of these cards require PC adapters that are usually supplied with the
cards.


Card Reader Cover
Make sure you keep the
rubber cover provided in
the card reader when
not in use. This will help
prevent foreign objects
and/or dust getting in to
the card reader.

Figure 2 - 2
Right View

1
1.

Card Reader

Multi-In-1 Push-Push Card Reader 2 - 3
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Mouse Driver
If you are using an external mouse your operating system may be
able to auto-configure
your mouse during its
installation or only enable its basic functions.
Be sure to check the
device’s user documentation for details.

Touchpad and Buttons/Mouse
The Touchpad is an alternative to the mouse; however, you can also add a mouse to
your computer through one of the USB ports. The Touchpad buttons function in
much the same way as a two-button mouse.

2 - 4 Touchpad and Buttons/Mouse
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Elan TouchPad
Once you have installed the touchpad driver (see “Touchpad” on page 4 - 7) you
can configure the functions by double-clicking the touchpad driver icon
in the
notification area of the taskbar (or from Options in the ELAN tab in the Mouse
control panel in Windows). You may then configure the gestures and options to your
preferences.


Mouse Driver
If you are using an external mouse your operating system may be
able to auto-configure
your mouse during its
installation or only enable its basic functions.
Be sure to check the
device’s user documentation for details.

Figure 2 - 3
Mouse Properties
(ELAN tab) &
Taskbar Icon

Touchpad and Buttons/Mouse 2 - 5
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The Elan Smart-Pad control panel allows you to use a specific gesture (action) on
the surface of the touchpad to perform specific actions to manipulate documents, objects and applications.

2

Click the menu tabs (One-finger, Multi-finger or Additional) and then the function
button on the left to access the Configuration controls in the right panel. Click the
tick box to Enable most of the controls and click Apply to save the settings. Click
the close icon
or Yes to close the control panel.

Figure 2 - 4
Smart-Pad Control
Panel (Button)
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Click the Function Description
tion.
Click the Default

button to get a detailed description of any func-

2

button to set any of the functions to the default setting.

Figure 2 - 5
Smart-Pad Control
Panel with
Function
Description

Touchpad and Buttons/Mouse 2 - 7
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One-Finger

2

Tapping
One-Finger tapping is equivalent to clicking the left mouse button to perform a
point/click/select function.

Figure 2 - 6
Tapping

Button
The left and right touchpad buttons may be configured to perform any action listed
in the Button drop-down menu.

Figure 2 - 7
Button
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Drag and Drop
You can select the different drag and drop methods from the menu provided. The object can be released when you lift the finger off the touchpad, when you tap again or
after a set time delay.

2

Figure 2 - 8
Drag and Drop

Edge Scroll
Enable Vertical or Horizontal Scroll from this menu. You can configure the width
of the scrollable area by adjusting the slider accordingly. To scroll vertically, tap the
right edge of the touchpad and drag the finger up and down. To scroll horizontally,
tap the bottom edge of the touchpad and drag your finger left or right.

Figure 2 - 9
Edge Scroll
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Edge Swipe
Enable Edge Swipe to use a single finger to scroll from the edges of the touchpad to
perform the designated function in Windows 8.

2

Figure 2 - 10
Edge Swipe
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Multi-Finger

2

Zooming
Place two fingers on the touchpad (for best results use the tips of the fingers) and
slide them apart to zoom in, or closer together to zoom out.

Figure 2 - 11
Zooming

Scrolling
The Two-Finger scrolling feature works in most scrollable windows and allows you
to scroll horizontally and vertically. Tap the pad surface and slide both fingers in the
direction required (vertically or horizontally as long as the option is selected).

Figure 2 - 12
Scrolling

Note that the scrolling direction is opposite to that of a standard mouse wheel configuration.
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Rotation
You can rotate objects by using a two-finger gesture. Touch and rotate using two fingers on the pad in the direction required. Alternatively place a finger down on the
pad and rotate the other finger around it in a circular motion (clockwise or counterclockwise).

2

Figure 2 - 13
Rotation

Three Finger Swipe
This gesture is used to activate a Page Up/Page Down operation. Swipe three fingers
quickly to the left to go to the previous page, or to the right to go to the next page.
After you release your fingers from the pad the page changes, and make sure to lift
your fingers immediately after the page change.

Figure 2 - 14
Swipe Page
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Additional
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Palm Tracking
This feature helps guard against accidental contact such as palms resting on the pad.
Use the slider to adjust the sensitivity of the feature as appropriate.

Figure 2 - 15
Palm Tracking

Sensitivity
Adjust the level of finger pressure required for the cursor to respond from this menu.

Figure 2 - 16
Sensitivity
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Volume Adjustment
The sound volume level
can be set using the volume control in the Settings menu in the
Charms Bar.

Audio Features
You can configure the audio options on your computer from the Sound control
panel in Windows, or from the Realtek HD Audio Manager icon in the taskbar
notification area/control panel (right-click the taskbar notification area icon
to
bring up an audio menu). The volume may also be adjusted by means of the volume
icon in the taskbar or the audio slider in the Settings menu (see sidebar).

Right-click the icon
to access the menu
above.

Figure 2 - 17
Realtek Audio
Manager
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Features & Components

Setup for Audio Recording

2

To record audio sources on your computer at optimum quality follow the instructions below:
1.
2.
3.

4.

Go to the Control Panel.
Click Realtek HD Audio Manager (Hardware and Sound), or right-click the
taskbar icon
and select Sound Manager.
Click Microphone Effects (tab) in Microphone (tab), and then click to select
Noise Suppression (button), or adjust the Recording Volume level to around 60,
to obtain the optimum recording quality.
Click OK to close the control panel and save the settings.

Figure 2 - 18
Realtek Audio
Manager Recording Setup

Audio Features 2 - 15
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Chapter 3: Power Management
Overview
To conserve power, especially when using the battery, your computer power management conserves power by controlling individual components of the computer
(the monitor and hard disk drive) or the whole system. This chapter covers:
•
•
•
•
•
•

The Power Sources
Turning On the Computer
Power Plans
Power-Saving States
Configuring the Power Buttons
Battery Information


OS Note
Power
management
functions will vary slightly depending on your
operating system. For
more information it is
best to refer to the user’s
manual of your operating system.

The computer uses enhanced power saving techniques to give the operating system
(OS) direct control over the power and thermal states of devices and processors. For
example, this enables the OS to set devices into low-power states based on user settings and information from applications.

Overview 3 - 1
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Forced Off
If the system “hangs”,
and the Ctrl + Alt + Del
key combination doesn’t
work, press the power
button for 4 seconds, or
longer, to force the system to turn itself off.

The Power Sources
The computer can be powered by either an AC/DC adapter or a battery pack.

AC/DC Adapter
Use only the AC/DC adapter that comes with your computer. The wrong type of AC/
DC adapter will damage the computer and its components.
1.
2.
3.
4.

Attach the AC/DC adapter to the DC-in jack on the right of the computer.
Plug the AC power cord into an outlet, and then connect the AC power cord to the
AC/DC adapter.
Raise the lid/LCD to a comfortable viewing angle.
Press the power button to turn “On”.

Battery
The battery allows you to use your computer while you are on the road or when an
electrical outlet is unavailable. Battery life varies depending on the applications and
the configuration you're using. To increase battery life, let the battery discharge
completely before recharging (see “Battery FAQ” on page 3 - 18).
We recommend that you do not remove the battery. For more information on the battery, please refer to “Battery Information” on page 3 - 14.

3 - 2 The Power Sources
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Turning On the Computer
Now you are ready to begin using your computer. To turn it on simply press the power button on the front panel.
When the computer is on, you can use the power button as a Stand by/Hibernate/
Shutdown hot-key button when it is pressed for less than 4 seconds (pressing and
holding the power button for longer than this will shut the computer down). Use
Power Options (Hardware and Sound) in the Windows control panel to configure
this feature.


Power Button as Stand by or Hibernate Button
You can use the OS’s “Power Options” control panel to set the power button to send the
system into Stand by or Hibernate mode (see your OS’s documentation, or “Configuring
the Power Buttons” on page 3 - 9 for details).

Turning On the Computer 3 - 3
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Shutting the Computer Down
Note that you should always shut your computer down by choosing the Shut down
command as this will help prevent hard disk or system problems. Use the Shut down
or sign out item in the Context Menu (right-click the lower left corner of the screen
to bring up the menu).

3

You can also use the Power Menu in Settings in the Windows 8.1 Charms Bar. If
you want to add Hibernate/Sleep to the Power Menu see “Adding Hibernate/Sleep
to the Power Menu” on page 3 - 10.
Charms Bar

Figure 3 - 1
Shut Down/Restart

3 - 4 Shutting the Computer Down

Desktop App

Start Screen
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Power Plans
The computer can be configured to conserve power by means of power plans. You
can use (or modify) an existing power plan, or create a new one.
The settings may be adjusted to set the display to turn off after a specified time, and
to send the computer into Sleep after a period of inactivity.
Click Change plan settings and then click Change advanced power settings to access further configuration options in Advanced Settings.


Resuming
Operation
See Table 3 - 1, on
page 3 - 11 for information on how to resume
from a power-saving
state.

Password
It is recommended that
you enable a password
on system resume in order to protect your data.

Figure 3 - 2
Power Plan
Advanced Settings

Power Plans 3 - 5

3

Power Management
Each Windows power plan will also adjust the processor performance of your machine in order to save power. This is worth bearing in mind if you are experiencing
any reduced performance (especially under DC/battery power).

3

Choose High performance (you may need to click Show additional plans to view
the High performance plan) for maximum performance when the computer is powered from an AC power source. Choose the Power saver (bear in mind that this
scheme may slow down the overall performance of the computer in order to save
power) for maximum power saving when the computer is battery (DC power) powered.

Figure 3 - 3
Power Plans

3 - 6 Power Plans

Click to Show/Hide
additional
power plans
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Power-Saving States
You can use power-saving states to stop the computer’s operation and restart where
you left off. Win 8.1 uses the Sleep, Hibernate and Shut Down power-saving
states.

Sleep
In Sleep all of your work, settings and preferences are saved to memory before the
system sleeps. When you are not using your computer for a certain length of time,
which you specify in the operating system, it will enter Sleep to save power.
The PC wakes from Sleep within seconds and will return you to where you last left
off (what was on your desktop) without reopening the application(s) and file(s) you
last used.
If your mobile PC in Sleep is running on battery power the system will use only a
minimum amount of power. After an extended period the system will save all the
information to the hard disk and shut the computer down before the battery becomes
depleted.


Wake On LAN
Support
Wake-On-LAN is only
supported from Sleep or
Hibernate states in
Windows.
If you require your computer to wake up from
network activity in Windows then make sure
that the computer is either in Sleep or Hibernate.
Wake-On-LAN is not
supported from Shutdown states in Windows.

To add Sleep to the Power Menu see “Adding Hibernate/Sleep to the Power
Menu” on page 3 - 10.

Power-Saving States 3 - 7
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Hibernate
Hibernate uses the least amount of power of all the power-saving states and saves
all of your information on a part of the hard disk before it turns the system off. If a
power failure occurs the system can restore your work from the hard disk; if a power
failure occurs when work is saved only to memory, then the work will be lost. Hibernate will also return you to where you last left off within seconds. You should
put your mobile PC into Hibernate if you will not use the computer for a period of
time, and will not have the chance to charge the battery. To add Hibernate to the
Power Menu see “Adding Hibernate/Sleep to the Power Menu” on page 3 - 10.

3

Shut down
You should Shut down the computer if you plan to install new hardware (don’t forget to remove the battery and follow all the safety instructions in Chapter 6), plan
to be away from the computer for several days, or you do not need it to wake up and
run a scheduled task. Returning to full operation from Shut down takes longer than
from Sleep or Hibernate.

Figure 3 - 4
Power Menu

3 - 8 Power-Saving States
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Configuring the Power Buttons
The power/sleep button (Fn + F4 key combo) and closed lid may be set to send the
computer in to a power-saving state. Click Choose what the power buttons do on
the left menu in Power Options to bring up the menu.


Password
Protection
It is recommended that
you enable a password
on wake up in order to
protect your data.
However you can disable this setting from the
Power Options menu
by clicking Require a
password on wakeup
in the left menu, and selecting the options (click
Change settings that
are currently unavailable).

Figure 3 - 5
Power Options
Define Power
Buttons

Configuring the Power Buttons 3 - 9

3

Power Management
Adding Hibernate/Sleep to the Power Menu
Add Hibernate/Sleep to the Power Menu as follows.
1.
2.
3.
4.
5.

3

Go to the Power Options (Hardware and Sound) control panel.
Click “Change settings that are currently unavailable”
Click Choose what the power buttons do.
Click to put a tick in the Hibernate/Sleep box under Shutdown settings.
Click Save Changes and close the control panel.

Figure 3 - 6
Power Options
Define Power
Buttons - Shutdown
Settings
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Resuming Operation
You can resume operation from power-saving states by pressing the power button,
or in some cases pressing the sleep button (Fn + F4 key combo).
Power Status

Icon

3

To Resume

Color

Table 3 - 1
Power Off

Off

Press the Power Button
Press the Power Button

Sleep

Blinking Green

Resuming
Operation

Press the Sleep Button (Fn + F4 Key Combo)
Off (battery)
Hibernate

Press the Power Button
Orange (AC/DC adapter)

Display Turned Off

Green

Press a Key or Move the Mouse/Touchpad




Power Button
When the computer is on, you can use the power button as a Sleep/Hibernate/Shut Down
hot key button when it is pressed for less than 4 seconds (pressing and holding the power
button for longer than this will force the computer to shut down).

Closing the Lid
If you have chosen to
send the computer to
Sleep when the lid is
closed, raising the lid
will wake the system up.

Configuring the Power Buttons 3 - 11

Power Management


3

Power Conservation
Modes
The Energy Star setting
will result in maximum
power saving, but with
the possible loss of
some performance.

Power Conservation Modes
This system supports Energy Star power management features that place computers (CPU, hard drive, etc.) into a low-power sleep modes after a designated period
of inactivity. Adjust Power Conservation Modes from the Control Center:
1.
2.
3.

Press the Fn + Esc key combination to toggle the Control Center on/off.
Click either the Performance, Balanced or Energy Star button.
Click in a blank area of the icon or press a key on the keyboard to exit Power
Conservation Mode without making any changes.

Setting the mode to Balance will give power
saving matched with
performance.
Performance will give
optimum computer performance but with less
power conservation.

Figure 3 - 7
Control Center
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Energy Star
Display Sleep Mode
Note that the Energy Star
setting will put the display
into sleep after no more than
15 minutes of user inactivity.

Power Management
Ctrl + Alt + Delete Key Combination
You can use the CTRL + ALT + DEL key combination from almost any of the Windows 8 interfaces/Apps to bring up a full-screen displaying Lock, Switch User, Log
off, Change a password and Task Manager options. If you click the Power icon
in the lower right corner of the screen a power management option menu appears to
display Sleep, Shut down, and Restart.

3

Figure 3 - 8
Ctrl + Alt + Delete
Menu

To fully control all the power options (including Hibernate mode) go to the Power
Options control panel and configure the power button, sleep button and lid to perform the function selected.

Configuring the Power Buttons 3 - 13
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Low Battery
Warning
When the battery is critically low, immediately
connect the AC/DC
adapter to the computer
or save your work, otherwise, the unsaved
data will be lost when
the power is depleted.

Battery Information
Follow these simple guidelines to get the best use out of your battery.

Battery Power
Your computer’s battery power is dependent upon many factors, including the programs you are running, and peripheral devices attached. You can set actions to be
taken (e.g. Shut down, Hibernate etc.), and set critical and low battery levels from
power plan Change plan settings > Change advanced power settings (see Figure
3 - 3 on page 3 - 6).
Click the battery icon
charge status.

Figure 3 - 9
Battery Icon
(Notification Area) &
Battery Advanced
Settings
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in the notification area to see the current battery level and
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Conserving Battery Power
• Use a power plan that conserves power (e.g Power saver), however note that
this may have an affect on computer performance.
• Lower the brightness level of the LCD display. The system will decrease LCD
brightness slightly to save power when it is not powered by the AC/DC adapter.
• Reduce the amount of time before the display is turned off.
• Close wireless, Bluetooth, modem or communication applications when they are
not being used.
• Disconnect/remove any unnecessary external devices e.g. USB devices,
ExpressCards etc.


Windows Mobility
Center
The Windows Mobility
Center control panel
provides an easy point
of access for information
on battery status, power
plans used and wireless
device status etc.

Figure 3 - 10
Windows Mobility
Center
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Battery Life
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Battery life may be shortened through improper maintenance. To optimize the life
and improve its performance, fully discharge and recharge the battery at least
once every 30 days.
We recommend that you do not remove the battery yourself. If you do need to remove the battery for any reason (e.g. long term storage or system upgrade) see “Removing the Battery” on page 6 - 3.

New Battery
Always completely discharge, then fully charge, a new battery (see “Battery FAQ”
on page 3 - 18 for instructions on how to do this).

Recharging the Battery with the AC/DC Adapter
The battery pack automatically recharges when the AC/DC adapter is attached and
plugged into an electrical outlet. If the computer is powered on, and in use, it will
take several hours to fully recharge the battery. When the computer is turned off but
plugged into an electrical outlet, battery charge time is less. Refer to “LED Indicators” on page 1 - 8 for information on the battery charge status, and to “Battery Information” on page 3 - 14 for more information on how to maintain and properly
recharge the battery pack.
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Power Management

Proper handling of the Battery Pack



• DO NOT disassemble the battery pack under any circumstances
• DO NOT expose the battery to fire or high temperatures, it may explode
• DO NOT connect the metal terminals (+, -) to each other

Caution
Danger of explosion if
battery is incorrectly replaced.


Damaged Battery Warning
Should you notice any physical defects (e.g. the battery is bent out of shape after being
dropped), or any unusual smells emanating from the notebook battery, shut your computer
down immediately and contact your distributor/supplier. If the battery has been dropped we
do not recommend using it any further, as even if the computer continues to work with a
damaged battery in place, it may cause circuit damage, which may possibly result in fire. It
is recommended that you replace your computer battery every two years.

Replace only with the
same or equivalent type
recommended by the
manufacturer. Discard
used battery according
to the manufacturer’s instructions.

Battery Information 3 - 17
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Battery FAQ
How do I completely discharge the battery?
Use the computer with battery power until it shuts down due to a low battery. Don’t
turn off the computer even if a message indicates the battery is critically low, just let
the computer use up all of the battery power and shut down on its own.
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1.
2.

Save and close all files and applications.
Create a power plan for discharging the battery and set all the options to Never.

Figure 3 - 11
Power Plan Create
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3.

Click Change plan settings (after creating it) and click Change plan settings >
Change advanced power settings.

3

Figure 3 - 12
Change Plan
Settings / Change
Advanced Power
Settings
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4.
5.

Scroll down to Battery and click + to expand the battery options.
Choose the options below (click Yes if a warning appears):

3

Figure 3 - 13
Power Options
Advanced Settings Battery

•
•
•
•
•

Low battery levels = 0%
Critical battery Levels = 1%
Low battery action = Do Nothing
Critical battery action (On battery) = Shut Down
Critical battery action (Plugged in) = Do Nothing
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How do I fully charge the battery?
When charging the battery, don’t stop until the LED charging indicator light changes
from orange to green.
How do I maintain the battery?
Completely discharge and charge the battery at least once every 30 days or after
about 20 partial discharges.
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Chapter 4: Drivers & Utilities
This chapter deals with installing the drivers and utilities essential to the operation or
improvement of some of the computer’s subsystems. The system takes advantage of
some newer hardware components for which the latest versions of most available operating systems haven’t built in drivers and utilities. Thus, some of the system components won’t be auto-configured with an appropriate driver or utility during
operating system installation. Instead, you need to manually install some system-required drivers and utilities.

What to Install
You will need to attach an external DVD drive to install the drivers from the Device
Drivers & Utilities + User’s Manual disc. The disc contains the drivers and utilities
necessary for the proper operation of the computer. Table 4 - 1, on page 4 - 4 lists
what you need to install and it is very important that the drivers are installed by
the method outlined in this chapter, and in the order indicated.
Note that the information included on the following pages is for Windows 8.1 only.
A separate manual and set of drivers are provided on the Device Drivers & Manual
Disc for Windows 8.
Module Driver Installation
The procedures for installing drivers for the Wireless LAN, Intel Technology and Bluetooth & WLAN Combo modules are provided in “Modules & Options” on page 7 - 1.


Driver Installation &
Power
When installing drivers make sure your
computer is powered
by the AC/DC adapter
connected to a working power source.
Some drivers draw a
significant amount of
power during the installation procedure, and if
the remaining battery
capacity is not adequate
this may cause the system to shut down and
cause system problems
(note that there is no
safety issue involved
here, and the battery will
be rechargeable within 1
minute).

What to Install 4 - 1
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Driver Installation
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1.
2.
3.
4.

Insert the Device Drivers & Utilities + User’s Manual disc into the attached DVD drive.
Click the message “Tap to choose what happens with this disc.”
Click Run autorun.exe.
Click Install Drivers (button), or Option Drivers (button) to access the Optional driver menu.

Figure 4 - 1 - Drivers Installer Screen 1
4 - 2 Driver Installation

Drivers & Utilities
5.
6.
7.

Check the driver installation order from Table 4 - 1, on page 4 - 4 (the drivers must be installed in this order)
which is the same as that listed in the Drivers Installer menu below.
Click to select the driver you wish to install, (you should note down the drivers as you install them).
Follow the instructions for each individual driver installation procedure as listed on the following pages.
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Figure 4 - 2 - Install Drivers
Driver Installation 4 - 3

Drivers & Utilities
Win 8.1 Driver
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Page #

Win 8.1 Optional Items

Page #

Chipset

Page 4 - 7

PC Camera Module (No driver required )

Page 7 - 2

Video (VGA)

Page 4 - 7

Wireless LAN Module

Page 7 - 11

NVIDIA Video (VGA)

Page 4 - 7

Bluetooth & WLAN Combo Module

Page 7 - 16

LAN

Page 4 - 7

Trusted Platform (Security) Module

Page 7 - 21

CardReader

Page 4 - 7

Intel® Rapid Storage Technology (required for hard disks in
AHCI/RAID mode and for Intel® Smart Response Technology)

Touchpad

Page 4 - 7

Intel® Rapid Start Technology

Page 7 - 45

Airplane

Page 4 - 8

Wireless Display (No driver required )

Page 7 - 58

Hot Key

Page 4 - 8

MEI Driver

Page 4 - 8

All drivers provided are for the Windows 8 operating system. It is very
important that the drivers are installed by the method outlined in this
chapter, and in the order indicated.

Audio

Page 4 - 8

Page 7 - 40 &
Page 7 - 41

Table 4 - 1 - Driver Installation
Note that you need to install both the WLAN & Bluetooth drivers for Intel and 3rd party WLAN & Bluetooth
Combo modules.
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Manual Driver Installation
Click Browse CD/DVD (button) in the Drivers Installer application and browse to the executable file in the
appropriate driver folder.
Windows Update
After installing all the drivers make sure you enable
Windows Update in order to get all the latest security
updates etc. (all updates will include the latest hotfixes
from Microsoft). See “Windows Update” on page 4 9 for instructions.

Updating/Reinstalling Individual Drivers
If you wish to update/reinstall individual drivers it
may be necessary to uninstall the original driver.To do
this go to the Control Panel in the Windows OS and
double-click the Programs and Features icon (Programs > Uninstall a program). Click to select the
driver (if it is not listed see below) and click Uninstall,
and then follow the on screen prompts (it may be necessary to restart the computer). Reinstall the driver as
outlined in this chapter.
If the driver is not listed in the Programs and Features menu:
1.
2.

3.

4.

Go to the Control Panel).
Double-click Device Manager (Hardware and
Sound > Devices and Printers > Device
Manager).
Double-click the device you wish to update/reinstall
the driver for (you may need to click “+” to expand
the selection).
Click Driver (tab) and click the Update Driver or
Uninstall button and follow the on screen prompts.

Driver Installation 4 - 5
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User Account Control
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If a User Account Control prompt appears as part of
the driver installation procedure, click Continue or
Allow, and follow the installation procedure as directed.

Windows Security Message
If you receive a Windows security message as part of
the driver installation process. Just click “Install this
driver software anyway” or “Install” to continue the
installation procedure.
You will receive this message in cases where the driver has been released after the version of Windows you
are currently using. All the drivers provided will have
already received certification for Windows.

New Hardware Found
If you see the message “New Hardware Found” during the installation procedure (other than when outlined in the driver install procedure), click Cancel
to close the window, and follow the installation procedure.
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Driver Installation General Guidelines
The driver installation procedure outlined in this Chapter
(and in Chapter 7 Options & Modules), are accurate at
the time of going to press.
Drivers are always subject to upgrade and revision so
the exact procedure for certain drivers may differ slightly. As a general guide follow the default on screen instructions for each driver (e.g. Next > Next > Finish)
unless you are an advanced user. In many cases a restart is required to install the driver.
Make sure any modules (e.g. WLAN or Bluetooth) are
ON (i.e. the system is not in Airplane Mode) before
installing the appropriate driver.

Drivers & Utilities

Driver Installation Procedure
Insert the Device Drivers & Utilities + User’s Manual
disc into an attached optical (DVD) drive and click Install Drivers/Option Drivers (button).

Chipset
1. Click 1.Install Chipset Driver > Yes.
2. Click Next > Yes > Next > Next.
3. Click Finish to restart the computer.
Video (VGA)
1. Click 2.Install VGA Driver > Yes.
2. Click Next > Yes > Next > Next.
3. Click Finish to restart the computer.
NVIDIA Video (VGA)
(For Model B Computers Only)

1. Click 3.Install NVIDIA VGA Driver > Yes.
2. Click AGREE AND CONTINUE (button) to
accept the terms of the license agreement.
3. Click Next.
4. Click Close to complete the installation.

Note: After installing the video driver go to the Display/Display Settings control panel to adjust the video settings to the highest resolution.

LAN
1. Click 4.Install LAN Driver > Yes.
2. Click Next > Install.
3. Click Finish.
CardReader
1. Click 5.Install Cardreader Driver > Yes.
2. Click Finish.
Touchpad
1. Click 6.Install Touchpad Driver > Yes.
2. Click Next.
3. Click the button to accept the license agreement
and click Next.
4. Click Finish > Restart Now to restart the computer.
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Airplane
Note: Do not use Update Driver in Device Manager to
install the Airplane Mode driver.

4

1. Click 7.Install Airplane Driver > Yes.
2. Click Next.
3. Click Finish to restart the computer.

Hot Key
1. Click 8.Install Hotkey AP > Yes.
2. Click Next > Next.
3. Click Finish > Finish to restart the computer.

Note that after installing the audio driver the system
will not return to the Drivers Installer screen. To install any of the optional drivers listed overleaf, eject
the Device Drivers & Utilities + User’s Manual disc
and then reinsert it (or double-click the disc icon in My
Computer), and click Option Drivers (button) to access the optional driver menu.
It is recommended you now also install the Intel Rapid Storage Technology driver (see “Intel® Rapid
Storage Technology” on page 7 - 40 - required for
AHCI mode hard disks).
(see over)

MEI Driver
1. Click 9.Install MEI Driver > Yes.
2. Click Next > Yes > Next.
3. Click Finish.
Audio
1. Click 10. Install Audio Driver > Yes.
2. Click Next.
3. Click Finish to restart the computer.
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Windows Update
After installing all the drivers make sure you enable Windows Update in order to get all the latest security updates etc. (all updates will include the latest hotfixes
from Microsoft).

4

To enable Windows Update make sure you are connected to the internet:
1.
2.
3.
4.
5.
6.

Go to the Control Panel.
Click Windows Update (System and Security/
Security).
Click Check for updates (button).
The computer will now check for updates (you
need to be connected to the internet).
Click Install now (button) to begin checking for the
updates.
Click Install updates (button) to install the
updates.
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Optional Drivers
See the pages indicated in Table 4 - 1, on page 4 - 4 for the driver installation procedures for any modules included in your purchase option.



4

Optional Driver
Installation Note
Note that driver # 4
(Sound Blaster Cinema)
is only required for
Model B computers.

Figure 4 - 3 - Option Drivers
Note that you need to install both the WLAN & Bluetooth drivers for Intel and 3rd party WLAN & Bluetooth
Combo modules.

4 - 10 Optional Drivers

BIOS Utilities

Chapter 5: BIOS Utilities
Overview
This chapter gives a brief introduction to the computer’s built-in software:
If your computer has never been set up, or you are making important changes to the
system (e.g. hard disk setup), then you should review this chapter first and note the
original settings found in Setup. Even if you are a beginner, keep a record of the settings you find and any changes you make. This information could be useful if your
system ever needs servicing.
There is one general rule: Don’t make any changes unless you are sure of what you
are doing. Many of the settings are required by the system, and changing them could
cause it to become unstable or worse. If you have any doubts, consult your service
representative.


BIOS Screens
Note that the BIOS
screens pictured on
these pages are intended for guidance in setting up your system’s
BIOS.
BIOS versions are subject to constant change
and revision, therefore
your computer’s actual
screens may appear
slightly different from
those pictured on these
pages.
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BIOS Settings
Warning

5

Incorrect settings can
cause your system to
malfunction. To correct
mistakes, return to Setup and restore the Previous
Values
with
<F2>, or Optimized Defaults with <F3>.

UEFI Boot & POST
When UEFI Boot is enabled, then the prompts
to press F2 or F7 will
not appear. However
you can still press F2 to
enter the setup, or F7 to
choose the preferred
boot device, if you press
the key immediately the
system boots up.

The Setup Utility
Each time you turn on the computer the system takes a few seconds to conduct a
POST, including a quick test of the on-board RAM (memory).
As the POST proceeds, the computer will tell you if there is anything wrong. If there
is a problem that prevents the system from booting, it will display a system summary
and prompt you to run Setup.
If there are no problems, the Setup prompt will disappear and the system will load
the operating system. Once that starts, you can’t get into Setup without rebooting.
The Aptio Setup Utility tells the system how to configure itself and manage basic
features and subsystems (e.g. port configuration).
To enter Setup, turn on the computer and press F2 (give the system a few seconds
to enter Setup). If the Boot Logo is enabled the F2 on screen will be highlighted to
illustrate that the system is processing the request during the POST (or press F7 for
boot options). If you get a “Keyboard Error”, (usually because you pressed F2 too
quickly) just press F2 again.
If the computer is already on, reboot using the Ctrl + Alt + Delete combination and
then hold down F2 when prompted. The Setup main menu will appear.
To see the boot options press F7 and choose your preferred boot device.
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Failing the POST
Errors can be detected during the POST. There are two categories, “fatal” and “nonfatal”.

Fatal Errors
These stop the boot process and usually indicate there is something seriously wrong
with your system. Take the computer to your service representative or authorized
distributor/supplier as soon as possible.

Non-Fatal Errors
This kind of error still allows you to boot. You will get a message identifying the
problem (make a note of this message!) and you can then press F7 (the F7 on screen
will be highlighted to illustrate that the system is processing the request) for boot
options.
Press F2 (give the system a few seconds to enter Setup; the F2 on screen will be
highlighted to illustrate that the system is processing the request) to run the Setup
program and try to correct the problem. If you still get an error message after you
change the setting, or if the “cure” seems even worse, call for help.

The Setup Utility 5 - 3

5

BIOS Utilities


Setup Menus

5

The
Setup
menus
shown in this section are
for reference only. Your
computer’s menus will
indicate the configuration appropriate for your
model and options.

Setup Screens
The following pages contain additional advice on portions of the Setup. Along the
top of the screen is a menu bar with menu headings. When you select a heading, a
new screen appears. Scroll through the features listed on each screen to make changes to Setup.
Instructions on how to navigate each screen are in the box at the bottom right side of
the screen.

Figure 5 - 1
Navigation Menu

If these tools are confusing, press F1 to call up a General Help screen, and then use
the arrow keys to scroll up or down the page.
The Item Specific Help on the upper right side of each screen explains the highlighted item and has useful messages about its options.
If you see an arrow next to an item, press Enter to go to a sub-menu on that subject. The sub-menu screen that appears has a similar layout, but the Enter key may
execute a command.

5 - 4 The Setup Utility

BIOS Utilities

Main Menu

Figure 5 - 2
Main Menu

System Time & Date (Main Menu)
The hour setting uses the 24-hour system (i.e., ØØ = midnight; 13 = 1 pm). If you
can change the date and time settings in your operating system, you will also change
these settings. Some applications may also alter data files to reflect these changes.
Main Menu 5 - 5
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SATA Port # (Main Menu)
Pressing Enter opens the sub-menu to show the configuration of a optical Device/
HDD on the computer’s SATA Ports.
CPU/System/Extended Memory: (Main Menu)
This item contains information on the CPU type and system memory, and is not user
configurable. The system will auto detect the amount of memory installed.

5
MB Series / BIOS Revision / KBC/EC firmware Revision
This item contains information on the BIOS version etc., and is not user configurable.
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Advanced Menu
Figure 5 - 3
Advanced Menu
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Intel Smart Connect Technology (Advanced Menu)
Smart Connect is a technology that makes checks on web applications that are open
even when the computer is in sleep mode, and thus allows updates to be made without the need to turn the computer on. The sub-menus here allow you to enable/disable the technology (ISCT Configuration).
Advanced Menu 5 - 7
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UEFI Boot

5

When UEFI Boot is enabled, then the prompts
to press F2 or F7 will
not appear. However
you can still press F2 to
enter the setup, or F7 to
choose the preferred
boot device, if you
press the key immediately the system boots
up.

Intel(R) Rapid Start Technology (Advanced Menu)
Enable/disable Intel(R) Rapid Start Technology from this menu. The rapid start
hibernation mode can resume power within 5 to 6 seconds and can remember your
computer's state with zero power.
Intel Anti-Theft Technology (Advanced Menu)
Anti-Theft Technology, which is built-in to the processor of the computer, allows
system administrators to render your computer useless to thieves by sending a poison pillencrypted SMS message over a 3G network etc. Administrators can also remotely unlock a recovered computer quickly, or direct the system to send location
information (GPS coordinates) back to a central server.
SATA Mode (Advanced Menu)
The SATA (Serial ATA) control is configured to operate in AHCI (Advanced Host
Controller Interface) mode.
Boot Logo (Advanced Menu)
Use this menu item to enable/disable the Boot Logo screen at system startup if you
have not enabled UEFI Boot. If you disable the Boot Logo you will not see the F2
Enter Setup or F7 Boot Options prompts on the screen, however you can still press
these keys, while the boot screen is displayed, to perform the Enter Setup or Boot
Option functions.
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Power On Boot Beep (Advanced Menu)
Use this menu item to enable/disable the beep as the computer starts up.
Battery Low Alarm Beep (Advanced Menu)
Use this menu item to enable/disable the battery low alarm beep.

5
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Security Menu

Security Menu

5

The changes you make
here affect the access
to the Setup utility itself,
and also access to your
machine as it boots up
after you turn it on.
These settings do not
affect your machine or
network
passwords
which will be set in your
software OS.

Figure 5 - 4
Security Menu

Set Supervisor Password (Security Menu)
You can set a password for access to the Aptio Setup Utility. This will not affect
access to the computer OS (only the Aptio Setup Utility).
5 - 10 Security Menu
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Note: To clear existing passwords press Enter and type the existing password, then
press Enter for the new password (without typing any password entry) and Enter
again to confirm the password clearance.

Set User Password (Security Menu)
You can set a password for user mode access to the Aptio Setup Utility. This will
not affect access to the computer OS, (only the Setup utility) unless you choose to
set a Password on Boot (see below). Many menu items in the Aptio Setup Utility
cannot be modified in user mode.
Note: You can only set the user password after you have set the supervisor password.
Password on boot: (Security Menu)
Specify whether or not a password should be entered to boot the computer (you may
only set a password on boot if a supervisor password is enabled). If “Enabled”
is selected, only users who enter a correct password can boot the system (see the
warning in the sidebar). The default setting is “Disabled”.


Password Warning
If you set a boot password (Password on boot
is “Enabled“), NEVER
forget your password.
The consequences of
this could be serious. If
you cannot remember
your boot password you
must contact your vendor and you may lose all
of the information on
your hard disk.
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Secure Boot Control (Security Menu)
Secure Boot prevents unauthorized operating systems and software from loading
during the startup process. Secure Boot Control is available as a menu option if you
have enabled UEFI Boot (see “UEFI Boot (Boot Menu)” on page 5 - 17). Enabling Secure Boot will bring up the Secure Boot Mode menu to enable you to configure Secure Boot as Standard (with a fixed secure boot policy) or Custom (which
enables you to make changes to the Key Management database).

5
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TPM Configuration (Security Menu)
This sub-menu will allow you to enable/disable Trusted Platform Module (TPM)
support, and to configure the TPM State. Select TPM Configuration and press Enter to access the sub-menu. Press Enter to access the Security Device Support menu
and select Enable to display the full TPM configuration menu (see “Trusted Platform (Security) Module” on page 7 - 21 for details).

5

Figure 5 - 5
Security Device
Support
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TPM State (Security Menu > Security Device Support Enabled)
Select TPM State, press Enter and select Enabled to change the TPM state to enabled. You will then need to press F4 to save the changes and restart the computer.

5
Figure 5 - 6
TPM State (Enabled)

As the computer restarts press F2 to enter the BIOS again and go to the TPM Configuration menu.

5 - 14 Security Menu

BIOS Utilities
Pending TPM operation (Security Menu > Security Device Support & TPM State
Enabled)
Select Pending operation, press Enter and select the option you require (if you are
initializing TPM you should select Enable Take Ownership). You will then need
to press F4 to save the changes and restart the computer. You can now install the
TPM driver (see “Trusted Platform Module (TPM) Driver Installation” on page 7
- 24) and then initialize the TPM.

5

Figure 5 - 7
Pending TPM
operation
(Enable Take
Ownership)
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Boot Menu
Figure 5 - 8
Boot Menu

5


BIOS Screens
Note that the BIOS
screens pictured on
these pages are intended for guidance in setting up your system’s
BIOS.
BIOS versions are subject to constant change
and revision, therefore
your computer’s actual
screens may appear
slightly different from
those pictured on these
pages.
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When you turn the computer on it will look for an operating system (e.g. Windows
7) from the devices listed in this menu, and in this priority order. If it cannot find
the operating system on that device, it will try to load it from the next device in the
order specified in the Boot Option Priorities.

BIOS Utilities
Boot Option Priorities (Boot Menu)
Press Enter to access the menu, use the arrow keys to move up and down the menu,
and press Enter to select a device from the Boot Option # list (the selected device
will be highlighted in white).
UEFI Boot (Boot Menu)
Enable/disable UEFI Boot from this menu. The Unified Extensible Firmware Interface (UEFI) specification provides a clean interface between operating systems and
platform firmware at boot time. In contrast to BIOS, UEFI defines a set of standard
boot and runtime services. The Network Stack item will be enabled as an option under UEFI Boot.

5
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Exit Menu
Figure 5 - 9
Exit Menu
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Click Save Changes and Reset to save all changes made. Choosing to Discard
Changes, or Exit Discarding Changes, will wipe out any changes you have made
to the Setup. You can also choose to restore the original Setup defaults that will return the Setup to its original state, and erase any previous changes you have made in
a previous session.
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Chapter 6: Upgrading The Computer
Overview
This chapter contains information on upgrading the computer. Follow the steps outlined to make the desired upgrades. If you have any trouble or problems you can contact your service representative for further help. Before you begin you will need:
• A small crosshead or Phillips screwdriver
• A small regular slotted (flathead) screwdriver
• An antistatic wrist strap


Warranty Warning
Please check with your
service representative
before undertaking any
upgrade procedures to
find out if this will VOID
your warranty.

Before working with the internal components you will need to wear an antistatic
wrist strap to ground yourself because static electricity may damage the components.
The chapter includes:
•
•
•
•
•

Removing the Battery
Removing the Component Bay Cover
Replacing the Component Bay Cover
Upgrading the Hard/Solid State Disk Drive
Upgrading the System Memory (RAM)

Please make sure that you review each procedure before you perform it.

Overview 6 - 1
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When Not to Upgrade


Power Safety
Warning

6

Before you undertake
any upgrade procedures, make sure that
you have turned off the
power, and disconnected all peripherals and
cables (including telephone lines). It is advisable to also remove your
battery in order to prevent accidentally turning
the machine on.

These procedures involve opening the system’s case, adding and sometimes replacing parts.
You should not perform any of these upgrades if:
•
•
•
•

Your system is still under warranty or a service contract
You don’t have all the necessary equipment
You’re not in the correct environment
You doubt your abilities

Under any of these conditions, contact your service representative to purchase or replace the component(s).


Removal Warning
When removing any cover(s) and screw(s) for the purposes of device upgrade, remember
to replace the cover(s) and screw(s) before turning the computer on.

Upgrading the Processor
If you want to upgrade your computer by replacing the existing processor with a faster/new one you will need to contact your customer service representative. We recommend that you do not do this yourself, since if it is done incorrectly you may
damage the processor or mainboard.
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Removing the Battery
If you are confident in undertaking upgrade procedures yourself, for safety reasons
it is best to remove the battery.
1.
2.
3.
4.
5.

Turn the computer off, and turn it over.
Slide the latch 1 in the direction of the arrow.
Slide the latch 2 in the direction of the arrow, and hold it in place.
Slide the battery out in the direction of the arrow 3 .
Reinsert the battery as illustrated below 4 .


Warranty Warning
Please check with your
service representative
before undertaking any
upgrade procedures to
find out if this will VOID
your warranty.

6
2

1
3

Figure 6 - 1
Battery Removal
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Removing the Component Bay Cover
1.
2.
3.
4.

Turn off the computer, and turn it over and remove the battery (see page 6 - 3).
Remove screws 1 & 2 from the bottom of the computer.
Slide the component bay cover until the cover and case indicators 3 are aligned.
Lift the bottom cover 4 off the computer case.

1
4

6
Figure 6 - 2
Removing the
Component Bay
Cover

2

3

3
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Replacing the Component Bay Cover
1.
2.
3.

Reinsert the component bay cover by placing it on the bottom case assembly, and
make sure the case markers line up 1 .
Apply downward pressure and sliding the cover in the direction of arrow 2 .
Replace screws 1 & 2 (Figure 6 - 2 on page 6 - 4) and battery (see page 6 - 3).

Figure 6 - 3
1

Replacing the
Component Bay
Cover

1

2
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HDD System
Warning

6

New HDD’s are blank. Before you begin make sure:
You have backed up any
data you want to keep from
your old HDD.
You have all the discs required to install your operating
system
and
programs.
If you have access to the internet, download the latest
application and hardware
driver updates for the operating system you plan to install. Copy these to a
removable medium.

Upgrading the Hard/Solid State Disk Drive
The hard disk drive (or solid state drive) can be taken out to accommodate other 2.5"
serial (SATA) hard disk/solid state drives with a height of 7mm (h) (see “Storage”
on page D - 2). Follow your operating system’s installation instructions, and install
all necessary drivers and utilities (see “Driver Installation” on page 4 - 2), when
setting up a new hard disk/solid state drive.
See the following pages for the appropriate information:
• See “Removing the HDD” on page 6 - 9.
• See “Removing the SSD From the Component Bay” on page 6 - 10

6 - 6 Upgrading the Hard/Solid State Disk Drive

Upgrading The Computer

Removing the Hard Disk Bay Cover
1.
2.
3.
4.

Turn off the computer, and turn it over and remove the battery (see page 6 - 3).
Remove screws 1 & 2 from the bottom of the computer.
Slide the HDD bay cover in the direction of arrow 3 until the cover and case
indicators 4 are aligned.
Remove the HDD bay cover 5 .

4

Figure 6 - 4
1

Hard Disk Bay
Cover Removal

2
4
3

5
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Replacing the HDD Bay Cover
1.
2.
3.

Reinsert the HDD bay cover by placing it on the bottom case assembly, and make
sure the case markers line up 1 .
Apply downward pressure with both thumbs at points 2 & 3 and slide the cover
in the direction of the arrows as illustrated.
Replace screws 1 & 2 (Figure 6 - 4 on page 6 - 7) and battery (see page 6 - 3).

Figure 6 - 5

6

Replacing the HDD
Bay Cover

1

1

2
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Removing the HDD
1.
2.
3.
4.
5.
6.

Remove the HDD bay cover (see page 6 - 7).
Grip the tab 1 and slide the HDD assembly in the direction of arrow 2 .
Remove the HDD assembly 3 .
Remove screws 4 & 5 and the cover 6 .
Replace the HDD assembly by using a finger to push it in at point 7 in the
direction of arrow 8 .
Replace the component bay cover and screws.

Figure 6 - 6
HDD Removal &
Insertion

2

1

3
5
6
8
4
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Removing the SSD From the Component Bay
1.
2.
3.
4.
5.
6.

6

7.

Remove the component bay cover (see page 6 - 4).
The SSD slot is at point 1 on the mainboard.
Remove screw 2 .
The SSD 3 will pop-up and you can then remove it.
Replace the SSD by angling it as illustrated, and then fit the connector firmly into
the slot.
The SSD module’s pin alignment will allow it to only fit one way. Make sure the
module is seated as far into the slot as it will go. DO NOT FORCE the module; it
should fit without much pressure.
Press the SSD module down towards the mainboard and replace screw 2 and
the component bay cover.

Figure 6 - 7

2

Component Bay SSD Removal

3
2
1
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Upgrading the System Memory (RAM)
The computer has two memory sockets for 204 pin Small Outline Dual In-line (SODIMM) DDR3L type memory modules (see “Memory” on page D - 2 for details of
supported module types).
1.
2.

Turn off the computer, and turn it over and remove the battery (see page 6 - 3)
and component bay cover (see page 6 - 4).
The memory sockets will be visible at point 1 .

6

Figure 6 - 8
Removing the
Component Bay
Cover

1
1
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3.

Gently pull the two release latches on the sides of the memory socket in the
direction indicated by the arrows ( 2 & 3 ) in Figure 6 - 9.

Figure 6 - 9
RAM Module
Release Latches

2

3
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2

3

Contact Warning
Be careful not to touch
the metal pins on the
module’s
connecting
edge. Even the cleanest
hands have oils which
can attract particles, and
degrade the module’s
performance.

Figure 6 - 10
RAM Module
Removal

4.

The RAM module will 4 pop-up, and you can remove it.


Single Memory
Module Installation
If your computer has a
single memory module,
then insert the module
into the Channel 0
(JDIMM1) socket.
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5.
6.
7.

8.
9.

Pull the latches to release the second module if necessary.
Insert a new module holding it at about a 30° angle and fit the connectors firmly
into the memory slot.
The module’s pin alignment will allow it to only fit one way. Make sure the module
is seated as far into the slot as it will go. DO NOT FORCE the module; it should fit
without much pressure.
Press the module in and down towards the mainboard until the slot levers click into
place to secure the module.
Replace the component bay cover.

6
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Chapter 7: Modules & Options
Overview
This chapter contains information on the following modules, which may come with
your computer, depending on the configuration purchased. If you are unsure please
contact your service representative.
•
•
•
•
•
•

PC Camera Module
Wireless LAN Module
Bluetooth & WLAN Combo Module
Trusted Platform (Security) Module
Sound Blaster Cinema EQ
Intel® Rapid Storage Technology

•
•
•
•
•

Intel® Smart Response Technology
Intel® Rapid Start Technology
Intel® Smart Connect Technology
Wireless Display
3G Module


Wireless Device
Operation Aboard
Aircraft
The use of any portable
electronic transmission
devices aboard aircraft
is usually prohibited.
Make sure the WLAN &
Bluetooth module(s)
are OFF if you are using
the computer aboard
aircraft by putting the
system in to Airplane
Mode (see Table 1 - 4,
on page 1 - 11).
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PC Camera Module
When the PC Camera application is run the LED indicator to the left of the camera
will be illuminated in red (see 2 Figure on page 1 - 7). Note that you need to use
the Camera app in Windows to take pictures and capture video. Use the Fn + F10
key combination (see “Function/Hot Key Indicators” on page 1 - 11) to toggle
power to the PC Camera module.
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PC Camera Audio Setup
If you want to capture video & audio with your camera, it is necessary to setup the
audio recording options in Windows.
1.
2.
3.
4.
5.
6.

Go to the Control Panel.
Click Sound
(Hardware and Sound) and click Recording (tab).
Right-click hold and release Microphone (Realtek High Definition Audio) and
make sure the item is not disabled.
Double-click Microphone (or select Properties from the right-click menu).
Click Levels (tab), and adjust the Microphone and Microphone Boost sliders to
the level required.
Click OK and close the control panels.

7
Figure 7 - 1
Audio Setup for PC
Camera

Right-click
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Camera App
1.

Figure 7 - 2

2.

Run the Camera app from the Start screen by clicking on the Camera app icon
.
The camera interface will display two buttons on the right side of the screen.

Camera App
Buttons


7

Exposure
Use the slider to adjust
the Exposure level.

3.
4.
5.

Figure 7 - 3
Camera Options
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The upper button
is used to record video, and the lower button
is used
to take still pictures.
Right-click on the screen to bring up menu buttons at the bottom of the screen.
These buttons enable you to access the camera roll (where captured pictures and
video are displayed), set the timer (the time period before capture begins; 3
seconds, 10 seconds or Off) and set the exposure level using the slider to obtain
the best results.
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Camera Options
The Camera Options settings may be accessed as follows:
1.
2.
3.
4.

Run the Camera app from the Start screen by clicking on the Camera app icon
.
While the camera app is running access the Charms Bar (e.g. click Use the
Windows logo key
+ D key combination).
Click Settings and then click Options.
You can adjust the Photo Aspect Ratio, select the Microphone, Hide/Show grid
lines and turn Location Info on or off from the Options panel.

7

Figure 7 - 4
Camera Options
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Taking Pictures/Capturing Video
1.
2.
3.
4.
5.

7

Figure 7 - 5
Pictures - Camera
Roll
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Run the Camera app from the Start screen by clicking on the Camera app icon
.
Right-click the screen and select the timer if you require a countdown before
capture.
Click the appropriate icon to take a picture or start video capture (if video capture
begins a timer will appear in the bottom corner of the screen).
To stop video capture click the main window again (or click the stop icon
).
Captured photos and videos will be saved to a Camera Roll folder within the
Pictures folder.

Modules & Options

Camera Roll
1.
2.
3.
4.

Run the Camera app from the Start screen by clicking on the Camera app icon
.
Right-click on the screen to bring up menu buttons at the bottom of the screen.
Click Camera Roll.
Click the arrows
/
(on either side of the screen) to browse through the
captured photos/video, and back to the Camera app.

Editing Photos
1.

Clicking on a captured photo will bring up an app bar with a series of buttons.

Figure 7 - 6
Edit Buttons
(for Still Photos)

2.
3.
4.
5.
6.
7.
8.

The Camera butt ton will take you back to the home screen of the camera app.
Click Delete to remove any photo from the camera roll (you will be asked to click
Delete again to confirm the deletion).
The Open With butt ton will allow you to select a program with which to open the
photo.
You can click Set as Lock screen to set the photo as the lock screen picture.
Clicking Slide Show will create a slide show of photos/video in the camera roll.
Click Rotate to rotate the picture through 90 degrees.
Use the handles to Crop any captured picture, and click Apply to make the
changes (you can change the Aspect ratio by clicking the button and selecting an
aspect ratio from the menu). You can Save a copy (create another copy of the
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photo with the edited changes), Update original (which changes the original
picture permanently) or Undo any changes.
9. Click the Edit button to bring up a full suite of tools to edit the photo.
10. Click on the menu headings on the left, and then click on the tool on the right to
edit the photo as required.

Edit Menu

7

Basic Fixes

Light

Color

Effects

Figure 7 - 7
Editing Tools

11. After the editing process is completed right-click on the photo to Save a copy
(create another copy of the photo with the edited changes), Update original
(which changes the original picture permanently), Undo any changes or Cancel
the editing.
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Editing Photos
1.

Clicking on a captured video will bring up an app bar with a series of buttons.

Figure 7 - 8
Edit Buttons
(for Video)
2.
3.
4.
5.

Click Delete to remove any video from the camera roll (you will be asked to click
Delete again to confirm the deletion).
The Open With butt ton will allow you to select a program with which to run the
Video.
Clicking Slide Show will create a slide show of photos/video in the camera roll.
Click Trim to edit the video. Use the round buttons at either end of the slider to
adjust the video length and click Save a copy to save the changes made.

7

Figure 7 - 9
Trim Video
(for Video Files)

Click to select and move the rounded buttons to edit the video.
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Video File Size
Note that capturing high resolution video files requires a substantial amount of disk
space for each file. After recording video, check the video file size (right-click the
file and select Properties) and the remaining free space on your hard disk (go to My
Computer, right-click the hard disk, and select Properties). If necessary you can
remove the recorded video file to a removable medium e.g. CD, DVD or USB Flash
drive.

7

Note that the Windows 8.1 system requires a minimum of 16GB (32-bit) or 20GB
(64-bit) of free space on the C: drive system partition. In order to prevent system
problems it is recommended that you move any large sized captured video file to a
location other than the C: drive.
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Wireless LAN Module
If you have included an Intel® or 3rd Party WLAN module in your purchase option
make sure that the module is on (i.e. the system is not in Airplane Mode) before installing the driver.
Make sure you install the drivers in the order indicated in Table 4 - 1, on page 4 - 4.
Note that you need to install both the WLAN & Bluetooth drivers for the WLAN
& Bluetooth Combo modules.


Wireless Device
Operation Aboard
Aircraft
The use of any portable
electronic transmission
devices aboard aircraft
is usually prohibited.
Make sure the WLAN &
Bluetooth module(s)
are OFF if you are using
the computer aboard
aircraft by putting the
system in to Airplane
Mode (see Table 1 - 4,
on page 1 - 11).

Wireless LAN Module 7 - 11
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3rd Party 802.11b/g/n Driver Installation
1. Make sure the system is not in Airplane Mode, and then insert the Device
Drivers & Utilities + User’s Manual disc into an attached DVD drive.
2. Click Option Drivers (button).
3. Click 1.Install WLAN Driver > Yes.
4. Click Next.
5. Click Finish to restart the computer.
6. The operating system is the default setting for Wireless LAN control in
Windows (see page 7 - 13).

7
Intel® WLAN Driver Installation
1. Make sure the system is not in Airplane Mode, and then insert the Device
Drivers & Utilities + User’s Manual disc into an attached DVD drive.
2. Click Option Drivers (button).
3. Click 1.Install WLAN Driver > Yes.
4. Click in the tickbox to agree to the End User License Agreement and click
Install.
5. Click Finish.
6. The operating system is the default setting for Wireless LAN control in
Windows (see page 7 - 13).
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WLAN Configuration in Windows
You can configure a wireless connection using one of the following options, however make sure the Wireless LAN module is turned on (and not in Airplane Mode)
before configuration begins.
Charms Bar
1.
2.
3.

Go to the Charms Bar.
Select Settings and then click the WiFi icon (it should read Available under the
icon and Airplane mode should be Off).
A list of available access points will appear.

7

Figure 7 - 10
WiFi Settings
(Charms Bar) &
Networks
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4.
5.
6.
7.
8.

Double-click an access point to connect to it (or click it and click Connect).
Enter a network security key (password) if required, and click Next.
You can choose to find other devices or not.
When you are connected to the network access point it will display Connected
.
Select any connected network and click Disconnect
to disconnect from a
connected access point.

7

Figure 7 - 11
Networks
Connected /
Disconnect

9.

You can click the Airplane Mode button to turn the mode (including Bluetooth) On
or Off.
10. Alternatively you can click the WiFi button to turn just the WiFi On or Off.
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Desktop Mode
1.
2.
3.
4.
5.
6.
7.

Switch to the Windows Desktop (click the app or use the Windows logo key
D key combination).
Click the wireless icon
in the notification area of the taskbar.
A list of available access points will appear.
Double-click an access point to connect to it (or click it and click Connect).
Enter a network security key (password) if required, and click Next.
You can choose to find other devices or not.
Select any connected network and click Disconnect to disconnect from a
connected access point.

+

7

Figure 7 - 12
Windows Desktop
Taskbar Notification
Area WLAN
Connection
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Bluetooth & WLAN Combo Module
If your purchase option includes the Combination Wireless LAN & Bluetooth
module (either Intel® or 3rd Party) then install the driver as instructed overleaf.
Make sure that the module is on (i.e. the system is not in Airplane Mode) before installing the driver.


Bluetooth Data Transfer

7

Note that the transfer of data between the computer and a Bluetooth enabled device is supported
in one direction only (simultaneous data transfer is not supported). Therefore if you are copying
a file from your computer to a Bluetooth enabled device, you will not be able to copy a file from
the Bluetooth enabled device to your computer until the file transfer process from the computer
has been completed.
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3rd Party Bluetooth (V4.0) Combo Driver Installation
1. Make sure the system is not in Airplane Mode, and then insert the Device
Drivers & Utilities + User’s Manual disc into an attached DVD drive.
2. Click Option Drivers (button).
3. Click 2.Install Combo BT Driver > Yes.
4. Click Next.
5. Click Finish to restart the computer.
6. See “Bluetooth Configuration in Windows” on page 7 - 18 for configuration instructions.
Intel Bluetooth Combo Driver Installation
1. Make sure the system is not in Airplane Mode, and then insert the Device
Drivers & Utilities + User’s Manual disc into an attached DVD drive.
2. Click Option Drivers (button).
3. Click 2.Install Combo BT Driver > Yes.
4. Click Next > Next.
5. Click in the tickbox to accept the license and click Next.
6. Click Next > Finish.
7. See “Bluetooth Configuration in Windows” on page 7 - 18 for configuration instructions.


High Speed Bluetooth
Data Transfer
The Combination Wireless LAN & Bluetooth
module supports high
speed data transfer. However to achieve such
transfer speeds, both devices must support
high speed data transfer.
To obtain high speed
data transfer make sure
that both the WLAN and
Bluetooth modules are
powered on.
Check your Bluetooth
compatible device’s documentation to confirm it
supports high speed data
transfer.
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Bluetooth Headset
Stereo Setup
To setup a Bluetooth
headset to support stereo audio see page 8 14.

Bluetooth Configuration in Windows
You can configure a Bluetooth connection as below, however make sure the Bluetooth module is on (or the system is not in Airplane Mode) before configuration.
Desktop Mode
1.
2.
3.

7

Switch to the Windows Desktop (click the App or use the Windows logo key
D key combination).
Click the notification area of the taskbar and double-click the Bluetooth icon
click and select Show Bluetooth Devices).
The Bluetooth item in PC and Devices will appear.
OR

Charms Bar
1.
2.
3.

Go to the Charms Bar.
Select Settings and then click Change PC Settings.
Select the Bluetooth item in PC and Devices.

Figure 7 - 13
Bluetooth Taskbar
Icon & Change PC
Settings (Charms
Bar -Settings)
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4.
5.

Make sure that Bluetooth is turned on and a list of discovered devices will appear.
Double-click the device you want to pair with the computer and click Pair.

Figure 7 - 14
PC and Devices Bluetooth

7
6.

On first connection the computer will provide you with a pairing code to be entered
onto the device.

Figure 7 - 15
Enter the Passcode

7.
8.

Enter the code into your Bluetooth enabled device and click Yes on the computer
to complete the pairing.
Select a device and click Remove Device to disconnect from any device.
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To Make your Computer Discoverable to Bluetooth Devices
1.
2.
3.
4.

Switch to the Windows Desktop (click the app or use the Windows logo key
+
D key combination).
Click the notification area of the taskbar, click the Bluetooth icon
and click
Open Settings.
Click Options, and make sure that Allow Bluetooth devices to find this
computer check box (Discovery) has a tick inside it.
Make sure that the Alert me when a new Bluetooth device wants to connect
check box (Connections) has a tick inside it, if you want to be notified when a
Bluetooth device wants to connect.

7

Figure 7 - 16
Bluetooth Settings
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Trusted Platform (Security) Module
If your purchase option includes the TPM security chip, this allows you to create
and manage digital certificates for user and platform authentication. This type of security is usually administered within large enterprises and organizations, and therefore requires implementation by a system administrator before users can access
security features.
Individual users can use the TPM as an authentication with the fingerprint reader.
Make sure you have administrator’s rights to your computer, and have a Windows
password enabled for full security protection. In addition Make sure you prepare
a removable media (e.g. a USB flash drive) to store passwords etc. before beginning the TPM initialization process.
Before setting up the TPM functions you must initialize the security platform.
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Enabling & Activating TPM
1.
2.
3.
4.
5.
6.

7

Restart the computer.
Enter the Aptio Setup Utility pressing F2 during the POST/startup.
Use the arrow keys to select the Security menu.
Select TPM Configuration and press Enter to access the sub-menu.
Press Enter to access the Security Device Support menu and select Enable to
display the full TPM configuration menu.
Select TPM State, press Enter and select Enabled to change the TPM state to
enabled. You will then need to press F4 to save the changes and restart the
computer.

Figure 7 - 17
TPM State
(Enabled)

7.

As the computer restarts press F2 to enter the BIOS again and go to the TPM
Configuration menu.
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8.

Select Pending operation, press Enter and select the option you require (if you
are initializing TPM you should select Enable Take Ownership). You will then
need to press F4 to save the changes and restart the computer.

Figure 7 - 18
Pending operation
(Enable Take
Ownership)

9.

You can now install the TPM driver (see “Trusted Platform Module (TPM)
Driver Installation” on page 7 - 24) and then initialize the TPM.
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Trusted Platform Module (TPM) Driver Installation
1. Make sure you have enabled and activated the TPM in the BIOS before
installing the driver.
2. Insert the Device Drivers & Utilities + User’s Manual disc into an attached
DVD drive.
3. Click Option Drivers (button).
4. Click 3.Install TPM Driver > Yes.
5. Click Next.
6. Click the button to accept the license and click Next.
7. Click Next > Next > Install.
8. Click Finish > Yes to restart the computer.
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Initializing TPM
1.

2.

3.

4.
5.

Switch to the Desktop app and click the TPM icon right-click the icon
in the
notification area of the taskbar, and select Security Platform Initialization (or
click the Security Platform State taskbar bubble).
Click User Settings (tab) and click Yes, or right-click the icon
in the
notification area of the taskbar, and select Security Platform Initialization (or
click the Security Platform State taskbar bubble).
The Quick Initialization method will automatically be selected for you (if you need
to use advanced settings provided by your network administrator then select
Advanced Initialization).
You will need to use a removable media (e.g. a USB Flash Drive) to store
passwords and data (keep the media in a safe place until required).
Select the drive you want to use from the drop-down menu and click Next.

7

Figure 7 - 19
Security Platform
Quick Initialization
Wizard
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6.


Help

7.

Choose the Security Platform Features you want to use by clicking the
appropriate tickbox.
Enter a Basic User Password (and re-type to confirm it) and click Next.

Right-click the icon
in
the notification area of the
taskbar to bring up the menu
to select Help or How to use
the Security Platform Features.

7

You can also click the Help
button in any of the Infineon
Security Platform Settings
Tool tabs to bring up specific
help topics on each tab.

Figure 7 - 20
Settings

8.
9.
10.
11.
12.

Click Next to confirm the settings.
The computer will then initialize the settings.
Click Finish.
Click the tabs and control panels to adjust the settings.
Double-click the icon
in the taskbar notification area to access the Infineon
Security Platform Settings Tool, or right-click the icon
and select a menu
item.
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Infineon Security Platform Settings Tool
The Infineon Security Platform Settings Tool allows you to manage and check the
TPM state, manage your password information, and to backup and restore the TPM
data. As TPM is usually administered within large enterprises and organizations,
your system administrator will need to assist you in managing the information here.


Menus
Note that not all the
menus pictured here will
be available for access.
The menu items that appear will be dependent on
your configuration settings etc. (see the Help
file for full details).

Figure 7 - 21
Infineon Security
Platform Settings
Tool
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User Settings
This page allows the settings to be configured for the currently logged in Infineon
Security Platform user including the ability to change the password, configure secure e-mail, file and folder encryption and Enhanced Authentication. You can also
import or delete certificates protected by the security platform.

7

Figure 7 - 22
Infineon Security
Platform Settings
Tool (User Settings)
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Backup
Here you can configure backup and restore operations. Backup files contain the
computer identification and user identification information which is used to match
the machine name and user name with the current machine and user during restoration.

Figure 7 - 23
Infineon Security
Platform Settings
Tool (Backup)
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Migration
The Migration tab is used to help securely transfer keys and certificates from one
platform to another.

7

Figure 7 - 24
Infineon Security
Platform Settings
Tool (Migration)
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Password Reset
Use Password Reset to reset basic user passwords when required.

Figure 7 - 25
Infineon Security
Platform Settings
Tool
(Password Reset)
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BitLocker
BitLocker Drive Encryption can be used in conjunction with the TPM to encrypt
data on the disk and is done via the Microsoft BitLocker Control Panel Applet.
Click Configure and select a drive to be encrypted and then follow the Wizard to
begin the encryption process.

7

Figure 7 - 26
Infineon Security
Platform Settings
Tool
(BitLocker)
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Access the Microsoft BitLocker Drive Encryption control panel applet from the
Windows control panel (System and Security).

Figure 7 - 27
BitLocker Drive
Encryption
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Advanced
Configure all the Security Platform owner and policy settings from the Advanced
tab. The settings that can be changed are for the local computer only.

7

Figure 7 - 28
Infineon Security
Platform Settings
Tool
(Advanced)
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Sound Blaster Cinema EQ
(For Model B Computers Only)
Install the Sound Blaster Cinema EQ to allow you to configure the audio settings
to your requirements for the best performance in games, music and movies.

Sound Blaster Cinema EQ Installation
1. Insert the Device Drivers & Utilities + User’s Manual disc into an attached
DVD drive.
2. Click Option Drivers (button).
3. Click 4.Install SB Cinema EQ > Yes.
4. Choose the setup language and click Next.
5. Click Yes to accept the license.
6. Click Next > Full Installation (button).
7. Click Next > Finish to restart the computer.


Creative Software
AutoUpdate
Run the application from
the shortcut in the Start
screen and make sure
you are connected to
the internet, then click
Next and follow the on
screen instructions to
update the software.

Sound Blaster Cinema EQ Activation
On the first run of Sound Blaster Cinema EQ you will may to activate the application.
1.
2.
3.
4.
5.

To activate the application you will need to be connected to the internet.
Double-click the Activate icon
on the desktop and click the Activate button.
The program will connect to the internet to verify the activation key.
Click Finish to complete the application activation.
Restart the computer after the process is complete.
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Sound Blaster
Cinema & HDMI

7

Sound Blaster Cinema Application
Run the Sound Blaster Cinema control panel from the notification area of the taskbar (or from the item in the Start menu). Click on the tabs to access the any of the
control panel menus.

Note that the Sound
Blaster Cinema audio
effects do not apply to
audio
generated
through an HDMI connection.

Figure 7 - 29
Sound Blaster
Cinema
(Taskbar
Notification Area
Icon & Menu)
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Sound Blaster Cinema Settings
Sound Blaster Cinema selects the built-in speakers by default and this setting may
cause some sound quality issues when using headphones. To adjust the settings for
headphones do the following:
1.
2.
3.
4.

Run the Sound Blaster Cinema application.
Select Settings from the menu.
Select Headphones from the drop-down menu (you can adjust the slider for
crossover frequency).
Click OK and close the application.

7
Figure 7 - 30
Settings

Sound Blaster Cinema
Select Headphones
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Settings

Sound Blaster Cinema Controls
Each control has an On/Off button to allow you to enable/disable the control, and
most controls feature a slider to adjust the levels.

You can use the drop
down menu to use presets for Music, Movie or
Games. Alternatively you
can use a Custom setting.

Menu

7
Figure 7 - 31
Sound Blaster
Cinema Controls

•
•
•
•

Surround: Provides virtual sound channels to control the level of immersion.
Crystalizer: Enhances audio to make it sound livelier.
Bass: Enhances the bass level of the sound system.
Smart Volume: Minimizes sudden volume changes to avoid the need for constant adjustment.
• Dialog Plus: Enhances dialogue levels for movies etc.
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Sound Blaster Cinema & HDMI
1.
2.
3.

When you connect an HDMI display to the HDMI-Out port, the Sound Blaster Cinema controls will be disabled.
A warning box will pop-up and will prompt “...Do you want to select another
audio device now?”.
Click No to continue using the HDMI audio output from your external display (do
not attempt to select another audio device when connected to the external HDMI
display).

Menu

Figure 7 - 32
Sound Blaster
Cinema HDMI
Display Warning
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Intel® Rapid Storage Technology
Install the Intel® Rapid Storage Technology to support your AHCI mode SATA
drive.

7

IRST Driver Installation
1. Insert the Device Drivers & Utilities + User’s Manual disc into an attached
DVD drive.
2. Click Option Drivers (button).
3. Click 5.Install IRST Driver > Yes.
4. Click Next.
5. Click in the tickbox to accept the license and click Next.
6. Click Next > Next > Next.
7. Click Finish to restart the computer.
8. Run the Intel® Rapid Storage Technology app from the Start screen.
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Intel® Smart Response Technology
Intel® Smart Response Technology is an Intel® Rapid Storage Technology
(RST) caching feature that accelerates computer system performance by using the
SSD as cache memory between the hard disk drive and system memory.
System Requirements to support Intel® Smart Response Technology:
• Intel Rapid Storage Technology software installed.
• A Solid State Drive (SSD) with a minimum capacity of 18.6GB (or with a partition on the drive formatted to more than 18.6GB e.g a 20GB partition set on the
SSD). Note that the SSD requires at least 5MB of free unpartitioned and unallocated space (if you have used all the disk space for the partition you will need to
shrink some of space for the cache memory’s use).


Intel® Smart
Response
Technology
Support for Intel® Smart
Response Technology
is dependent on your
processor. For details
contact your distributor/
supplier.

Figure 7 - 33
Computer
Management - Disk
Management Unallocated SSD
Space

See overleaf for instructions on enabling Intel® Smart Response Technology.
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Enabling Intel Smart Response Technology

7

1.
2.

Run the Intel® Rapid Storage Technology application.
Click Enable acceleration under Performance > Smart Response Technology (note
that you will at least 5MB of free unpartitioned and unallocated space on the SSD
otherwise the Smart Response Technology item will not appear).

3.
4.

Select the SSD to be used as a cache device.
Select the size from the SSD to be allocated for the cache memory (any remaining
space on the SSD can be used for data storage using the simple data single-disk
RAID 0 volume that is automatically created).

Figure 7 - 34
Intel® Rapid
Storage
Technology Performance
Enable
Acceleration
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5.
6.

Select the HDD (or RAID volume) to be accelerated (it is highly recommended that
you accelerate the system volume or system disk for maximum performance).
Select the acceleration mode, and then click OK (Enhanced mode is selected by
default).

Note: Enhanced mode (default): Acceleration optimized for data protection.
Maximized mode: Acceleration optimized for input/output performance.

7
Figure 7 - 35
Enable
Acceleration
Options
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7.

The page will refresh and report the new configuration in under Performance >
Smart Response Technology.

Figure 7 - 36

7

Intel® Rapid
Storage
Technology Performance
(Smart Response
Technology)
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Intel® Rapid Start Technology
Intel(R) Rapid Start Technology can resume power from Hibernation within 5 to
6 seconds and can remember your computer's previous state with zero power.
System Requirements to support Intel® Rapid Start Technology:
• Rapid Start Technology should be enabled in the BIOS (see ““Intel(R) Rapid
Start Technology (Advanced Menu)” on page 5 - 8).
• Intel Rapid Storage Technology software installed (see “Intel® Rapid Storage
Technology” on page 7 - 40).
• A Solid State Drive (SSD) with a minimum capacity of 18.6GB.
• The Solid State Drive (not the HDD) must be configured as outlined on the following pages to support Rapid Start Technology.
• The Windows operating system must be installed on the system hard disk drive,
and not on the Solid State Drive (SSD).


Operating System Installation
Note that in order for Intel(R) Rapid Start Technology to function properly the Windows
operating system must be installed on the system hard disk drive (e.g. the “C:” drive), and
the SSD should be configured as outlined on the following pages. Rapid Start will not function if the operating system is installed on the SSD.

See overleaf for instructions on enabling Intel® Rapid Start Technology.

Intel® Rapid Start Technology 7 - 45

7

Modules & Options

Intel® Rapid Start Technology Configuration
1.
2.
3.

Enable Intel(R) Rapid Start Technology from the BIOS (see “Intel(R) Rapid
Start Technology (Advanced Menu)” on page 5 - 8).
Go the Windows control panel and double-click Administrative Tools (System
and Security)> Computer Management > Storage > Disk Management
Right-click the SSD and select Shrink Volume from the menu.

7
Figure 7 - 37
Computer
Management
(Shrink SSD
Volume)

Shrink Volume
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4.

Enter the figure, which should be equal to amount of system memory (RAM)
in your computer, in “Enter the amount of space to shrink in MB”.

Figure 7 - 38
Shrink Volume
Size

7

5.

Click Shrink (any unallocated file space may be formatted for storage use).


Memory Size (Amount of Space to Shrink)
The figure entered in the “Enter the amount of space to shrink in MB” field above should be equal
to the amount of system memory in your computer. In the example above the system memory is 4GB
(1024MB * 4 = 4096GB). If you are unsure of your total system memory (RAM) then go to System
control panel (System and Security) and check Installed memory (RAM). The memory size will be displayed in GB so convert by multiplying the GB figure by 1024 to get the total in MB (e.g. 8GB =
8192MB).
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6.

Run the Desktop app and right-click the lower left hot corner (or use the Windows
Logo Key
+ X key combination) and select Command Prompt (Admin).

7.
8.

Type “DISKPART”.
At the DISKPART command type “list disk”.

Figure 7 - 39
Search for CMD
Prompt

7

Figure 7 - 40
Diskpart - List Disk
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9.

Type “select disk #” (# is disk number where you want to create the store
partition, so refer to the results obtained from "list disk" for exact disk number).
10. The message “Disk # is now the selected disk.” will appear.

Figure 7 - 41
Diskpart - Select
Disk #

7

11. Type “create partition primary”.
12. A “DiskPart succeeded in creating the specified partition.” message should
appear.

Figure 7 - 42
Diskpart - Create
Partition
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13. Type “detail disk”.

Figure 7 - 43
Diskpart - Detail
Disk

7
14. Type “select Volume #” (# is volume of your storage partition so refer to results
obtained from "detail disk" for the exact volume number).
15. The message “Volume # is now the selected volume.” will appear.

Figure 7 - 44
Diskpart - Select
Volume #
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16. Type the following, depending on the format of the SSD.

• For MBR formatted SSDs: “set id=84 override” (the id must be set to 84).
• For GPT formatted SSDs: “set id=D3BFE2DE-3DAF-11DF-BA40-E3A556D89593”.

Figure 7 - 45
Diskpart - Set id=

17. The message “DiskPart successfully set the partition ID.” will appear.
18. Close the CMD window.
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19. Go the Windows control panel and double-click Administrative Tools (System
and Security)> Computer Management > Storage > Disk Management.
20. The disk partition should read Healthy Hibernation Partition.

Figure 7 - 46

7

Computer
Management
(Healthy
Hibernation
Partition)

Healthy (Hibernation Partition)
21. Restart the computer.
22. Install the driver (see below).

Intel® Rapid Start Technology Driver Installation
1. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/
DVD drive.
2. Click Option Drivers (button).
3. Click 6.Install Rapid Start Driver > Yes.
4. Click Next > Next > Yes > Next > Next.
5. Click Finish to restart the computer.
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Intel® Smart Connect Technology
Intel® Smart Connect Technology periodically, and briefly, wakes the computer
from Sleep mode in order to update information for certain applications (e.g. to get
mail from Microsoft Outlook) as required. These updates can therefore be made
without having to turn the computer on, and applications will be up to date when the
computer resumes from Sleep mode (make sure that Intel Smart Connect Technology is enabled in the BIOS - see “Intel Smart Connect Technology (Advanced
Menu)” on page 5 - 7).
Note that the applications need to be on and running when the computer enters
Sleep mode in order to get updates.

Intel® Smart Connect Technology Driver Installation
1. Insert the Device Drivers & Utilities + User’s Manual disc into the DVD
drive.
2. Click Option Drivers (button).
3. Make sure that Intel Smart Connect Technology is enabled in the BIOS see “Intel Smart Connect Technology (Advanced Menu)” on page 5 - 7.
4. Click 7.Install ISCT Driver > Yes.
5. Click Next.
6. Click in the tickbox to accept the license and click Next.
7. Click Next > Install > Finish.
8. Click Yes to restart the computer.


Intel® Smart Connect
Technology System
Requirements
Note that in order to support Intel® Smart Connect Technology your
system will need to have
the item enabled in the
BIOS (see page 5 - 7).
In addition only certain Intel WLAN modules support this feature.
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Wireless Device
Operation Aboard
Aircraft
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The use of any portable
electronic transmission
devices aboard aircraft
is usually prohibited.
Make sure the WLAN &
Bluetooth module(s)
are OFF if you are using
the computer aboard
aircraft by putting the
system in to Airplane
Mode (see Table 1 - 4,
on page 1 - 11).

Intel® Smart Connect Technology Configuration
1.
2.
3.
4.

Access the Intel(R) Smart Connect Technology application from the Start menu.
Click Basic (tab) and adjust the slider to set the update frequency (note that the
slider balances between “More Frequent Updates” and “More Battery Life”).
Note the sidebar warning about the use of Intel(R) Smart Connect Technology
aboard aircraft and make sure your wireless LAN module is off during air travel.
In order to update any applications, they will need to be on and running when the
computer enters Sleep mode.

Figure 7 - 47
iSCT Basic
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5.
6.

Click Advanced (tab) to access the Extended Power Savings settings.
Extended Power Savings allows you to set a time period during which the
computer will update less often (e.g. at night while you are asleep or whenever you
are at work).

Figure 7 - 48
iSCT Advanced

7.

Updates set during this time period will be performed every two hours, and this will
override the settings selected in the Basic tab in order to conserve power
consumption.
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8.

Click the Help tab and click Topics to access the main Help menu.


Intel WLAN Modules

7

If your purchase option
includes an Intel WLAN
module, (with Intel’s
PROSet Wireless Connection
Utility
installed), Intel® Smart
Connect Technology
will search for WiFi networks around you that
you have previously accessed.
If no known WiFi networks are found, your
computer will not update
again until it recognizes
a known WiFi network.

Figure 7 - 49
iSCT Help
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9.

Disable Intel Rapid Start Technology by clicking the Off button, and clicking Save.
OR
10. Click Timer to make sure it is on, and adjust the slider to select a time to delay
entering Rapid Start from running, and click Save.

7
Figure 7 - 50
Intel® Rapid Start
Technology
Manager Settings
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Compatible
Adapters
For a list of compatible
display and audio adapters check the Intel website, or your distributor/
supplier.
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Wireless Display
Wireless Display uses your Wireless LAN module/WLAN Bluetooth Combo module (you need to make sure that your video adapter/display device is compatible with
your particular WLAN/Combo module) in conjunction with a compatible video
adapter/display device (purchased separately) to allow you to display the contents of
the notebook display on another display (e.g. HDTV), without the need to have cables stretching across a room.
You can use the wireless display to play games, browse the internet, display videos
or photo slide shows on your TV/external display without using HDMI or A/V cables.
Before configuring Wireless Display you will need to set up your compatible
adapter with your display/speakers. Connect the adapter using an HDMI or A/V cable and turn on the display (or in the case of speakers connect them to the wireless
speaker adapter with the cables provided with the adapter), and then set the display
to the appropriate input channel (see the documentation supplied with your compatible adapter/display for full details).
Note that no driver or application is required for wireless display in Windows 8.1.
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Wireless Display Configuration
1.
2.
3.
4.

Note that no driver or application is required for wireless display in Windows 8.1.
Go the Charms Bar, select Devices.
Click Project.
Click Add a wireless display.

7
Figure 7 - 51
Add a Wireless
Display
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5.

The system will then search for compatible display devices (this may take up to
60 seconds so allow time for this to complete).

6.
7.

Double-click any detected display device in the list.
You may then need to input a pin number for the device to which you are
connecting.
Click Next.

Figure 7 - 52
Searching For
Devices

7

8.

Figure 7 - 53
Enter PIN
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9.

The display will then connect (for specific settings for your display see the
documentation supplied with your compatible adapter/display for full details).
10. To disconnect from the display you can select it in PC and Devices > Devices and
click Remove Device > Yes; or go to the Project menu (Charms Bar > Devices)
and click Disconnect.

Figure 7 - 54
Remove Device/
Disconnect
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3G Module
If you have included an optional UMTS/HSPDA+ based 3G Module (Universal
Mobile Telecommunications System or High Speed Packet Access) module (see
“Communication” on page D - 3 for specification details) in your purchase option,
you do not require a driver/application installation for Windows 8.1. Follow the
instructions overleaf to install the USIM card (which will be provided by your service provider), and then use the Charms Bar Wireless icon to access the 3G network in the same manner as the WLAN (see page 7 - 64).

7


Important Notice
If your purchase option includes both Wireless LAN and 3G modules, then the appropriate
antennas will be installed. Note that In order to comply with FCC RF exposure compliance
requirements, the antenna must not be co-located or operate in conjunction with any other
antenna or transmitter.
Important Notice - 3G & Bluetooth/Wireless LAN Modules
In order to comply with FCC regulations you should NOT operate the 3G module and the
Bluetooth/Wireless LAN modules at the same time as this may disrupt radio frequency, and
cause interference. When the 3G module is powered on, make sure that the Bluetooth/
Wireless LAN modules are powered off.
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3G Module USIM Card Installation
If you have included an optional 3G module, follow the instructions below to install
the USIM card (which will be provided by your service provider).
1.
2.
3.
4.
5.
6.

Turn the computer off, remove the AC/DC adapter and turn it over.
Slide the latch 1 in the direction of the arrow.
Slide the latch 2 in the direction of the arrow, and hold it in place.
Grip the battery and remove it in the direction of arrow 3 .
Insert the USIM card 4 (at the rear of the battery compartment) as illustrated
below, until it clicks fully into position.
When reinserting the battery slide it in to the battery bay as illustrated 5 .

1

2

3


Power Safety
Warning
Before you undertake any
installation
procedures,
make sure that you have
turned off the power, and
disconnected all peripherals and cables (including
telephone lines). It is advisable to also remove your
battery in order to prevent
accidentally turning the machine on.

USIM Card Orientation

4

Note that the USIM card’s
readable side (with the
gold-colored
contacts)
should face upwards as illustrated.

5

Figure 7 - 55
USIM Card Insertion
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3G Configuration in Windows
You can configure a 3G connection as below, however make sure the system is not
in Airplane Mode before configuration begins.
Charms Bar
1.
2.

\

3.

7
Figure 7 - 56
Networks
Mobile Broadband
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Go to the Charms Bar.
Select Settings and then click the WiFi icon (it should read Available under the
icon and Airplane mode should be Off).
A list of available access points will appear under Mobile Broadband.

Modules & Options
4.
5.

Any 3G service provider (connection information is usually stored on the USIM
card) will appear under Mobile Broadband.
Double-click any connection icon under Mobile Broadband (or click and then click
Connect).

Figure 7 - 57
Mobile Broadband
(Connect)

6.
7.

The system will connect to your network.
A Connected will appear alongside the 3G connection (click the connection to
view the timer which indicates your connected time for the current session).
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Wireless Device
Operation Aboard
Aircraft

8.
9.

You can then access the internet, download e-mail etc. as per any internet
connection.
To disconnect you can select the connection and click Disconnect
.

The use of any portable
electronic transmission
devices aboard aircraft
is usually prohibited.

7

Make sure the system is
in Airplane Mode if you
are using the computer
aboard aircraft.

Figure 7 - 58
Mobile Broadband
(Disconnect)
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10. You need to either use Airplane Mode, or to turn the Mobile Broadband module
off aboard aircraft.
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EM820W 3G Module PIN Code & Power-Saving
Note that there may be some issues when a PIN Code is set for the EM820W 3G
module (if you are unsure of your module version contact your distributor/supplier)
in Windows, if Mobile Broadband has been turned off, and the system has resumed
from a power-saving state. To prevent any issues it is recommended that you simply do not enable a PIN for the EM820W 3G module. The following provides instructions for disabling the PIN code; for specific instructions on resolving the issue
where “Insert a SIM” appears in the connection see “Resolving the “Insert a SIM”
issue with the 3G Module (Windows 8.1)” on page 8 - 17.

7

Disabling a PIN code for a 3G Module
1.
2.

Go to the Charms Bar.
Click Change PC Settings.

Figure 7 - 59
Change PC Settings
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3.
4.
5.
6.
7.

Click Network.
Click the broadband connection under Mobile Broadband.
Scroll down to Security and click Remove PIN.
Enter the current PIN number and click OK.
It is recommended that you do not Enable a PIN for the EM820W 3G module.

7
Figure 7 - 60
Disable PIN
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Chapter 8: Troubleshooting
Overview
Should you have any problems with your computer, before consulting your service representative, you may want
to try to solve the problem yourself. This chapter lists some common problems and their possible solutions. This
can’t anticipate every problem, but you should check here before you panic. If you don’t find the answer in these
pages, make sure you have followed the instructions carefully and observed the safety precautions in the preface.
If all else fails, talk to your service representative. You should also make a record of what happened and what
remedies you tried.
Of course, if something goes wrong, it will happen at the most inconvenient time possible, so you should preview
this section just in case. If, after you’ve tried everything, and the system still won’t cooperate, try turning it off
for a few minutes and then rebooting. You will lose any unsaved data, but it may start working again. Then call
your service representative.

Overview 8 - 1
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Basic Hints and Tips
Many of the following may seem obvious but they are often the solution to a problem when your computer appears not to be working.
• Power - Is the computer actually plugged into a working electrical outlet? If plugged into a power strip,
make sure it is actually working. Check the LED Power & Communication Indicators (see “LED Indicators” on page 1 - 8) to see the computer’s power status.
• Connections - Check all the cables to make sure that there are no loose connections anywhere.

8

• Power Savings - Make sure that the system is not in Hibernate or Sleep mode by pressing the keys configured in your Power Options (see “Power-Saving States” on page 3 - 7), the Fn + F4 key combination, or
power button to wake-up the system.
• Brightness - Check the brightness of the screen by pressing the Fn + F8 and F9 keys to adjust the brightness.
• Display Choice - Press Fn + F7 to make sure the system is not set to “external only” display.
• Boot Drive - Make sure there are no optical media and/or USB storage devices in any connected drive
(this is a common cause of the message “Invalid system disk - Replace the disk, and then press any key” /
“Remove disks or other media. Press any key to restart”).

8 - 2 Basic Hints and Tips
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Backup and General Maintenance
• Always backup your important data, and keep copies of your OS and programs safe, but close to hand.
Don’t forget to note the serial numbers if you are storing them out of their original cases, e.g. in a CD wallet.
• Run maintenance programs on your hard disk and OS as often as you can. You may schedule these programs to run at times when you are not using your computer. You can use those that are provided free with
your OS, or buy the more powerful dedicated programs to do so.
• Write down your passwords and keep them safe (away from your computer). This is especially important if
you choose to use a Supervisor password for the BIOS (see “The Setup Utility” on page 5 - 2).
• Keep copies of vital settings files such as network, dialup settings, mail settings etc.(even if just brief notes).


Warranty
The CPU is not a user serviceable part. Opening this compartment, or accessing the CPU in any way, may violate your warranty.

Backup and General Maintenance 8 - 3
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Viruses
• Install an Anti-Virus program and keep the definitions file (the file which tells your program which viruses
to look for) up to date. New computer viruses are discovered daily, and some of them may seriously harm
your computer and cause you to lose data. Anti-Virus programs are commercially available and the definitions file updates are usually downloadable directly from the internet.

8

• Be careful when opening e-mail from sources you don’t know. Viruses are often triggered from within email attachments so take care when opening any attached file. You can configure most Anti-Virus programs to check all e-mail attachments. Note: You should also beware of files from people you know as the
virus may have infected an address book and been automatically forwarded without the person’s knowledge.
• Keep a “Bootable CD-ROM/DVD-ROM/USB storage device” (this CD/DVD/USB device provides basic
information which allows you to startup your computer) handy. You may refer to your OS’s documentation
for instructions on how to make one, and many Anti-Virus programs will also provide such a disk (or at
least instructions on how to make one).

8 - 4 Viruses
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Upgrading and Adding New Hardware/Software
• Do not be tempted to make changes to your Windows Registry unless you are very sure of what you are
doing, otherwise you will risk severely damaging your system.
• Don’t open your computer or undertake any repair or upgrade work if you are not comfortable with what
you are doing.
• Read the documentation. We can assume, since you are reading this that you are looking at the computer’s
manual, but what about any new peripheral devices you have just purchased? Many problems are caused by
the installation of new hardware and/or software. Always refer to the documentation of any new hardware
and/or software, and pay particular attention to files entitled “READ ME” or “READ ME FIRST”.
• When installing a new device always make sure the device is powered on, and in many cases you will need
to restart the computer. Always check that all the cables are correctly connected.
• Make sure you have installed the drivers for any new hardware you have installed (latest driver files are
usually available to download from vendor’s websites).

Upgrading and Adding New Hardware/Software 8 - 5
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• Thoroughly check any recent changes you made to your system as these changes may affect one or more
system components, or software programs. If possible, go back and undo the change you just made and see
if the problem still occurs.
• Don’t over complicate things. The less you have to deal with then the easier the source of the problem may
be found; Example - if your computer has many devices plugged into its ports, and a number of programs
running, then it will be difficult to determine the cause of a problem. Try disconnecting all of the devices and
restarting the computer with all the peripheral devices unplugged. A process of elimination (adding and
removing devices and restarting where necessary) will often find the source of a problem, although this may
be time consuming.
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Problems and Possible Solutions
Problem

Possible Cause - Solution

You turned on the power but it doesn’t
work.

Battery missing / incorrectly installed. Check the battery bay, make sure the
battery is present and seated properly (the design of the battery only allows it to
go in one way). Make sure there’s nothing interfering with the battery contacts.

The battery LED power indicator
blinking orange.

, is

Low Battery. Plug in the DC power source. If the computer doesn’t start up
immediately, turn it off then on again.

You are losing battery power too quickly.

The system is using too much power. If your OS has a Power Options scheme
(see “Power Plans” on page 3 - 5) check its settings. You may also be using a
peripheral device/USB device that is drawing a lot of power.

Actual battery operating time is shorter
than expected.

The battery has not been fully discharged before being recharged. Make sure
the battery is fully discharged and recharge it completely before reusing (see
“Battery Information” on page 3 - 14).
Power Options have been disabled. Go to the Control Panel in Windows and
re-enable the options.
A peripheral device/USB device is consuming a lot of power. Turn off/remove
the unused device to save power.

Problems and Possible Solutions 8 - 7
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Problem
The computer feels too hot.

Possible Cause - Solution
Make sure the computer is properly ventilated and the Vent/Fan intakes are not
blocked. If this doesn’t cool it down, put the system into Hibernate mode or turn
it off for an hour. Make sure the computer isn’t sitting on a thermal surface (see
“Overheating” on page 1 - 13/1 - 14). Make sure you’re using the correct
adapter.
Make sure that your notebook is completely powered off before putting it into a
travel bag (or any such container). Putting a notebook which is powered on in a
travel bag may cause the Vent/Fan intakes to be blocked.

Nothing appears on screen.

8

The system is in a power saving mode. Toggle the sleep/resume key
combination, Fn + F4 (see “Configuring the Power Buttons” on page 3 - 9).
The screen controls need to be adjusted. Toggle the screen control key
combinations Fn + F8/F9. If you’re connected to an external monitor, make sure
it’s plugged in and turned on. You should also check the monitor’s own
brightness and contrast controls.
The computer is set for a different display. Toggle the screen display key
combination, Fn + F7. If an external monitor is connected, turn it on.
The screen saver is activated. Press any key or touch the TouchPad.

No image appears on the external
monitor I have plugged in and powered
on.

You haven’t installed the video driver and configured it appropriately from the
Control Panel. See Appendix C for instructions on installing and configuring
the video driver.
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Problem

Possible Cause - Solution

You forget the boot password.

If you forget the password, you may have to discharge the battery of the CMOS.
Contact your service representative for help.


Password Warning
If you choose to set a boot password, NEVER forget your password. The consequences of this could be serious. If you cannot
remember your boot password you must contact your vendor and you may lose all of the information on your hard disk.

The sound cannot be heard or the volume
is very low.

The volume might be set too low. Check the volume control in the Volume
Control Panel in the Windows notification area, or use the key combination Fn
+ F5 and F6 (see “Function/Hot Key Indicators” on page 1 - 11) to adjust.

Unwelcome
typing.

Num Lock is turned ON (see “Function/Hot Key Indicators” on page 1 - 11).

numbers

appear

when

I am sliding my finger up and down on the
right side of the Touchpad to scroll a
Window and the Touchpad does not
respond.

There are different Touchpad versions available on this computer, and this
version requires tapping/holding to scroll. Either tap repeatedly, or hold the
finger down, at the top or bottom right of the Touchpad (depending on the
scrolling direction required) to scroll the window.

Problems and Possible Solutions 8 - 9
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Problem

Possible Cause - Solution


Other Keyboards
If your keyboard is damaged or you just want to make a change, you can use any standard USB keyboard. The system will
detect and enable it automatically. However special functions/hot keys unique to the system’s regular keyboard may not
work.

8

The system freezes or the screen goes
dark.

The system’s power saving features have timed-out. Use the AC/DC adapter,
press the sleep (Fn + F4) key combination, or press the power button if no LEDs
are lit.

The system never goes into a power
saving mode.

Power Options features are not enabled. Go to the Windows Power Options
menu and enable the features you prefer (see “Power-Saving States” on
page 3 - 7). Make sure you have enabled Hibernate mode from the control
panel.

The Wireless LAN/Bluetooth modules
cannot be detected.

The modules are off as the computer is in Airplane Mode. Check the LED
indicator
to see if it is in Airplane Mode (see “LED Indicators” on page 1 8). Use the Fn + F11 key combination to toggle Airplane Mode on/off (see
Table 1 - 4, on page 1 - 11).

The PC Camera module cannot be
detected.

The module is off. Press the Fn + F10 key combination in order to enable the
module (see “Function/Hot Key Indicators” on page 1 - 11). Run the camera
application to view the camera picture.
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Problem

Possible Cause - Solution

The Wireless LAN/Bluetooth modules
cannot be configured.

The driver(s) for the module(s) have not been installed. Make sure you have
installed the driver for the appropriate module (see the instructions for the
appropriate module in Chapter 7 "Modules & Options").

A file cannot be copied
connected Bluetooth device.

The transfer of data between the computer and a Bluetooth enabled device is
supported in one direction only (simultaneous data transfer is not
supported). If you are copying a file from your computer to a Bluetooth enabled
device, you will not be able to copy a file from the Bluetooth enabled device to
your computer until the file transfer process has been completed

to/from

a

I cannot obtain high speed Bluetooth data
transfer.

To obtain high speed Bluetooth data transfer take into account the following:

• To achieve high speed transfer speeds, both devices must support high
speed data transfer (i.e both the computer and the Bluetooth compatible device you are connecting to).
• Check your Bluetooth compatible device’s documentation to confirm it
supports high speed data transfer, and for configuration information.

Problems and Possible Solutions 8 - 11

8

Troubleshooting
Problem

Possible Cause - Solution

I have used Update Driver in Device
Manager (Unknown device > Other
Devices) to try and install the Airplane
Mode driver. Windows encountered a
problem in attempting to update the driver,
and a yellow exclamation mark appears
in Device Manager against the Unknown
device.

It is very important that the drivers are installed in the order indicated in Chapter
4 (which is the numbered installation order on the Device Drivers & Utilities +
User’s Manual disc). This issue can occur when drivers are manually installed,
and not in the correct order.
If you have attempted to Update Driver from the Device Manager control panel
and have encountered problems, then use the method below to correct this:
To correct this problem:

1.
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2.

3.
4.
5.
6.

Go to the Programs and Features (Programs) control panel in
Windows.
Select any installed Airplane Mode driver item (e.g. Insyde Airplane
Mode HID Mini-Driver), and click Uninstall/Change to uninstall the
current driver.
Restart the computer.
Insert the Device Drivers & Utilities + User’s Manual disc and click
Install Drivers (button).
Double-click the Airplane Driver item in the menu.
Follow the instructions to install the correct driver (you will need to
restart the computer as part of the installation process).
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Problem

Possible Cause - Solution

I have connected a Bluetooth Mouse but
it loses the Bluetooth connection and
no longer responds after a short period of
inactivity.

This is an issue with this mouse model and the Intel Wireless 7260 WLAN and
Bluetooth combo module series. To resolve this issue do the following:

1.
2.
3.
4.
5.
6.

Go to the Device Manager control panel in Windows.
Click the arrow alongside Bluetooth to expand the menu if required.
Double-click Intel(R) Wireless Bluetooth(R) 4.0 + HS Adapter.
Click the Power Management tab.
Make sure that the tickbox alongside “allow the computer to turn
off this device to save power” doesn’t have a tick alongside it.
Click OK and close the control panel.
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Figure 8 - 1 - Device Manager (Bluetooth)
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Problem

Possible Cause - Solution

When using a Bluetooth headset the
audio appears to be mono and not
stereo.

This is a common issue with Bluetooth headsets. To resolve this issue do the
following (you will need to repeat this procedure after every boot up, restart,
or when the system resumes from hibernation):

1.
2.
3.

Go to the Devices & Printers control panel in Windows.
Double-click the Bluetooth headset.
Click Connect to complete the stereo connection.

OR

1.
2.

8

3.

Go to the Sound control panel in Windows.
Right-click (in the Playback tab) the Bluetooth Stereo Audio device
(the default device is Headset).
Click Connect to complete the stereo connection.
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EM820W 3G Module PIN Code & Power-Saving
Note that there may be some issues when a PIN Code is set for the EM820W 3G module (if you are unsure of
your module version contact your distributor/supplier) in Windows, if Mobile Broadband has been turned off,
and the system has resumed from a power-saving state. To prevent any issues it is recommended that you
simply do not enable a PIN for the EM820W 3G module. The following provides instructions for disabling
the PIN code.
Disabling a PIN code for a 3G Module
1.
2.

Go to the Charms Bar.
Click Change PC Settings.

8

Figure 8 - 2 - Change PC Settings
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3.
4.
5.
6.
7.

Click Network.
Click the broadband connection under Mobile Broadband.
Scroll down to Security and click Remove PIN.
Enter the current PIN number and click OK.
It is recommended that you do not Enable a PIN for the EM820W 3G module.

8

Figure 8 - 3 - Disable PIN
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Resolving the “Insert a SIM” issue with the 3G Module (Windows 8.1)
1.

2.
3.
4.
5.
6.
7.
8.
9.

If a PIN was set for the EM820W 3G module, you have then switched Mobile broadband off (or put the system
in Airplane Mode) in Networks, and the system has just resumed from a power-saving state the following error
may occur.
On resuming from the power-saving state the standard procedure would be to go to Networks in the Charms
Bar and turn on Mobile broadband.
Go to the Charms Bar.
Select Settings and you will then note that the WiFi icon will read Unavailable.
Standard procedure would be to click the connection and enter the PIN number to unlock the connection.
In this instance you will note that the Mobile broadband connection will read Insert a SIM.
In this case you will need to restart the computer.
After system restart you can then connect to the Mobile Broadband as normal.
To fully resolve this issue it is recommended that you do not Enable a PIN for the EM820W 3G module.
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Appendix A: Interface (Ports & Jacks)
Overview
The following chapter will give a quick description of the interface (ports & jacks) which allow your computer
to communicate with external devices, connect to the internet etc.

A

Interface (Ports & Jacks) A - 1

Interface (Ports & Jacks)

Notebook Ports and Jacks
Item

Description

Card Reader Port

The card reader allows you to use some of the latest digital storage cards. Push the card into the
slot and it will appear as a removable device.

DC-In Jack

A

Plug the supplied AC/DC adapter into this jack to power your computer.

HDMI-Out Port

The HDMI-Out (High-Definition Multimedia Interface) is an audio/video connector interface for
transmitting uncompressed digital streams. This allows you to connect an external monitor, TV or
Flat Panel Display etc. as a display device by means of a HDMI cable. Note that HDMI carries
both audio and video signals.

Headphone-Out Jack

Headphones or speakers may be connected through this jack. Note: Set your system’s volume to
a reduced level before connecting to this jack.

Microphone-In Jack

RJ-45 LAN Jack

Plug an external microphone in to this jack to record on your computer.

This port supports LAN (Network) functions. Note that the RJ-45 jack has a cover that should be
opened before inserting/removing any cable (see “System Map: Right & Rear Views” on
page 1 - 14).
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Item

Description

Security Lock Slot

To prevent possible theft, a Kensington-type lock can be attached to this slot. Locks can be
purchased at any computer store.

USB 3.0 Ports

These USB 3.0 compatible ports (backwards-compatible with USB 2.0 however USB 3.0 will
transfer data much faster than USB 2.0) are for low-speed peripherals such as keyboards, mice
or scanners, and for high-speed peripherals such as external HDDs, digital video cameras or
high-speed scanners etc. Devices can be plugged into the computer, and unplugged from the
computer, without the need to turn the system off (if the power rating of your USB device is
500mA or above, make sure you use the power supply which comes with the device).

3.0

A

Interface (Ports & Jacks) A - 3
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Appendix B: Control Center
Overview
The following chapter will give a quick description of the functions of the Control Center. The Control Center
gives quick access to frequently used controls, power management features and enables you to quickly turn modules on/off. Click the Control Center icons to toggle the appropriate function, or hold the mouse button down
and move the slider where applicable. Certain functions will automatically be adjusted when a power mode is
selected. The Control Center in Windows 8.1 works under the Desktop app and not under the Start screen.
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Figure B - 1 - Control Center

Control Center B - 1

Control Center
Power Modes

You can set a Power Mode by clicking the appropriate icon at the top of the Control Center. Each power
mode will affect screen brightness, Touchpad and PC camera power etc.
You can click a Control Center icon to set an overall power mode and then click individual icons in the
Control Center to power on/off the Touchpad and PC camera.
Modes

Power Saving

Entertainment

Quiet

Performance

Power Plan

Power Saver

Power Saving

Power Saving

High
Performance

Power Conservation
Mode

Energy Star

Energy Star

Energy Star

Performance

Brightness

10

100

40

100

PC Camera

OFF

OFF

ON

ON

TouchPad

ON

ON

ON

ON

User
Defined

Icon

Table B - 1- Power Modes
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User Defined
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Control Center
Power Status
The Power Status icon will show whether you are currently powered by the battery, or by the AC/DC adapter
plugged in to a working power outlet. The power status bar will show the current battery charge state.
Brightness
The Brightness icon will show the current screen brightness level. You can use the slider to adjust the screen
brightness or the Fn + F8/F9 key combinations, or use the Fn+ F2 key combination to turn off the LED backlight
(press any key to turn it on again). Note that screen brightness is also effected by the Power Mode selected (see
Table B - 1, on page B - 2).
Volume
The Volume icon will show the current volume level. You can use the slider to adjust the Volume or the Fn +
F5/F6 key combinations, or use the Fn+ F3 key combination to mute the volume.
Power Conservation
This system supports Energy Star power management features that place computers (CPU, hard drive, etc.) into
a low-power sleep modes after a designated period of inactivity (see “Power Conservation Modes” on page 3 12). Click either the Performance, Balanced or Energy Star button.

Control Center B - 3
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Control Center
Sleep
Click the Sleep button to bring up the Hibernate
or Sleep
buttons, and click either button to have the
computer enter the appropriate power-saving mode (see “Power-Saving States” on page 3 - 7).
Display Switch
Click the Display Switch button to access the menu (or use the
priate attached display mode (see page C - 21).

+ P key combination) and select the appro-

Time Zone
Clicking the Time Zone button will access the Date and Time Windows control panel.
Desktop Background
Clicking the Desktop Background button will allow you to change the desktop background picture.

B

TouchPad/PC Camera
Click either of these buttons to toggle the TouchPad or camera module’s power status. A crossed out icon will
appear over the top left of the icon
when it is off. Note that the power status of the camera module is also
effected by the Power Mode selected (see Table B - 1, on page B - 2).
Caps Lock/Scroll Lock/ Number Lock
Click the button to toggle the appropriate lock mode.
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Appendix C: Video Driver Controls
The basic settings for configuring the LCD are outlined in “Video Features” on
page 1 - 32. Make sure you install the drivers in the order indicated in Table 4 - 1,
on page 4 - 4.

Video (VGA)
1. Insert the Device Drivers & Utilities + User’s Manual disc into an attached
DVD drive.
2. Click 2.Install VGA Driver > Yes.
3. Click Next > Yes > Next > Next.
4. Click Finish to restart the computer.
NVIDIA Video (VGA)


Video Card Options
Note that card types,
specifications and drivers are subject to continual
updates
and
changes. Check with
your distributor/supplier
for the latest details on
video cards supported.

DVMT Notes
DVMT is not local video
memory.

(For Model B Only)

1. Click 3.Install nVIDIA VGA Driver > Yes.
2. Click AGREE AND CONTINUE (button) to accept the terms of the
license agreement.
3. Click Next.
4. Click the Close button to complete the installation.
5.

DVMT will not function
in MS-DOS. DOS uses
the legacy memory indicated.

C - 1
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Dynamic Video Memory Technology
Intel® DVMT automatically and dynamically allocates as much (up to 1748MB)
system memory (RAM) as needed to the integrated video system (the video driver
must be installed). DVMT returns whatever memory is no longer needed to the operating system.

Model Differences
In this computer series Model B supports both the Intel(R) HD Graphics control
panel and the NVIDIA control panel, however Models A & C (which does not support NVIDIA® Optimus™ Technology) only support the Intel(R) HD Graphics
control panel.

C
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NVIDIA® Optimus™ Technology
(Model B Only)
Most notebook computers come with either a discrete or integrated graphics solution.

Discrete graphics solutions feature a dedicated Graphics Processing Unit (GPU)
which are capable of playing games, watching HD video or running GPU-based applications. However computers with discrete graphics solutions tend to be heavy in
power consumption, and slightly larger in size in order to incorporate the dedicated
discrete GPU.


iGPU or dGPU
Note the NVIDIA control
panel refers to Highperformance NVIDIA
processor (which is the
discrete GPU) and Integrated graphics (which
is the integrated GPU).

Integrated graphics solutions usually feature memory sharing technology to help
save power consumption and allow for longer battery life. However computers with
integrated graphics solutions will not usually run games, HD video or GPU-based
applications without severe limitations.
Nvidia® Optimus™ technology is a seamless technology designed to get best performance from the graphics system while allowing longer battery life, without having to manually change settings. Thus when an application is run that requires extra
performance or quality, then the system will run the discrete GPU (dGPU); when the
system does not require such enhanced performance it will let the integrated (iGPU)
handle it.

NVIDIA® Optimus™ Technology C - 3
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Customization
Options
Although Optimus is
completely seemless to
the user, NVIDIA also
allow customization options within the control
panel (see “Optimus™
Customization
Options” on page C - 26).

How Optimus Technology works
When the system is powered up and is displaying just the desktop, the dGPU will be
powered off. In this case the system is running in the same way as a system without
a discrete graphics solution. However when an application that requires use of the
dGPU is run (e.g, a game or HD Video), the dGPu is powered on and takes over the
processing duties. If the program is closed, then the dGPU will be powered back
down again until required.

C
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Intel® HD Graphics Control Panel
Advanced video configuration options are provided by the Intel® HD Control Panel. To access the control panel see below and overleaf:
1.

Click the Intel® HD Graphics Control Panel icon in the Start screen.

Figure C - 1
Start Screen
Intel® HD Graphics
Control Panel

C

(see over)
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Video Driver Controls
OR
2.

Right-click the Desktop and select Graphics Properties from the menu.

OR
3.
4.
5.

Click Advanced settings in the Screen Resolution control panel in Windows.
Click the Intel(R) HD Graphics Control Panel tab and click Graphics Properties
(button).
Double-click the Intel(R) HD Graphics control panel in the Windows Control
Panel.

Figure C - 2
Intel® HD Graphics
Control Panel

C
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You may make changes to any of the graphics properties by clicking the appropriate
menu panel and adjusting the settings on the right.

Figure C - 3
Intel® HD Graphics
Control Panel

C

Intel® HD Graphics Control Panel C - 7

Video Driver Controls
Sub-Menus
Some of the menu panels will also have sub-menus (in the top left corner of the menu
alongside the icon ) to display further configuration options.

Figure C - 4
Intel® HD Graphics
Control Panel
Sub-Menus

C
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Display
Click either Display Settings or Color to make display adjustments, including configuration for any attached external displays.


Multiple Display
At least one other display must be attached in
order to view multiple
display selection options.

Figure C - 5
Intel® HD Graphics
Control Panel
Display Settings

C
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Multiple Display

Click the Display menu at the top of the screen to display the sub-menus. The Multiple Displays menu allows you to configure the display mode of any attached displays (see “Attaching Other Displays” on page C - 19).

At least one other display must be attached in
order to view multiple
display selection options.

Figure C - 6
Intel® HD Graphics
Control Panel
Display Settings Multiple Displays
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Video Driver Controls
The Audio sub-menu allows you to configure the capability mode of any attached
displays if applicable (i.e. the attached display supports audio). Enable Audio
Without Video to keep audio on when the display blanks out for power saving purposes.

Figure C - 7
Intel® HD Graphics
Control Panel
Display Settings Audio

C
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3D
This menu allows you to choose how 3D images are displayed. Quality displays the
most detail, Balanced provides better computer performance with good quality and
Custom allows you to configure the Anisotropic Filtering, Vertical Sync and
Anti-Aliasing features to your preferences. Click Apply to save changes.

Figure C - 8
Intel® HD Graphics
Control Panel 3D

C
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Options
Options allows you to Customize Hot Keys (for opening the application, rotating
the display, scaling etc.,) to your preferences. Click Apply to save changes.

Figure C - 9
Intel® HD Graphics
Control Panel
Options

C
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Preferences

Click the Options menu at the top of the screen to display the sub-menus. The Information Center provides details on System Information, the Built-In Display
and any attached displays.

Go to the Preferences
sub-menu in Options to
configure the preferences for the Intel® HD
Graphics Control Panel.
Make sure you turn Tray
Icon On to display the
Intel® HD Graphics
Control Panel icon in the
notification area of the
taskbar (as below).

C
Figure C - 10
Intel® HD Graphics
Control Panel
Options Information Center
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Video
The Video Profiles menu allows you to brighten or darken movies, or to switch to
vivid colors. Click Basic or Advanced to adjust the video settings based on the Application Settings or Driver Settings. The Preview image will display a sample image using the current settings. You can Save Profile and name the Profile to recall
the settings at any time. Click Apply to save changes.

Figure C - 11
Intel® HD Graphics
Control Panel Video
(Basic - Driver
Settings)

C
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Video Driver Controls
Click the Video menu at the top of the screen to display the sub-menus.The Image
Enhancement menu allows you to adjust the Sharpness, Skin Tone Enhancement, Noise Reduction etc.Click Apply to save changes.

Figure C - 12
Intel® HD Graphics
Control Panel Video
Image
Enhancement Basic
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The Image Scaling and Gamut Mapping menus allow you to adjust these items.

Figure C - 13
Intel® HD Graphics
Control Panel Video
Image Scaling &
Gamut Mapping

C
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Display Devices & Options
Note that you can use external displays connected to the HDMI-Out port and/or external mini display port. See your display device manual to see which formats are
supported.


Attaching Displays
When you first attach an external display you may find that the desktop does not occupy
the full screen area. Use either the display’s auto adjust/configure controls, or the Intel(R)
HD Graphics Control Panel to configure the full screen display.

Display Mode
(Intel / Win8)

Table C - 1

C

Description

Single Display

One of the connected displays is used as the display device
(PC screen only or Second screen only).

Clone/Duplicate

Both connected displays output the same view and may be
configured independently

Extended / Extend

Both connected displays are treated as separate devices, and
act as a virtual desktop

Display Modes
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Attaching Other Displays



To Clone Displays:
1.
2.
3.
4.
5.

Attach your external display to the HDMI-Out port/mini display port, and turn it on.
Go to the Intel(R) HD Graphics Control Panel control panel and click Display >
Multiple Displays (sub-menu).
Click Clone from the Select Multiple Display Mode menu.
Click Apply, and OK to confirm the settings change.
You can select the displays to be used from the Select Active Displays menu.

Multiple Display
At least one other display must be attached in
order to view Multiple
Display selection options.

Figure C - 14
Display > Multiple
Displays (Clone)

C
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To Enable Extended Mode:


Display Settings
Extended Desktop
You can have different
Colors, Screen Area
and Monitor Refresh
Rates for each display
device provided your
monitor can support
them.

1.
2.
3.
4.

Attach your external display to the HDMI-Out port/mini display port, and turn it on.
Go to the Intel(R) HD Graphics Control Panel control panel and click Display >
Multiple Displays (sub-menu).
Click Extended from the Select Multiple Display Mode menu.
Click Apply, and OK to confirm the settings change.

You can drag the monitor icons to match the
physical layout of your
displays. Icons and programs may also be
dragged between the
displays.

C
Figure C - 15
Display > Multiple
Displays (Extended)
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Click the appropriate monitor icon
and drag it to match
the physical arrangement
you
wish to use (e.g. the
secondary display
may be extended
left/right/above/below the primary display).
Click Display Settings to make any
adjustments
required.
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Attaching Other Displays - Devices (Charms Bar)
You can configure attached displays from Devices (in the Charms Bar).
1.
2.
3.
4.

Attach your external display to the HDMI-Out port/mini display port, and turn it on.
Go the Charms Bar, select Devices.
Click Project (you may need to click Second Screen).
Click on any one of the options from the menu to select PC screen only,
Duplicate, Extend or Second screen only.


Windows Logo Key
+ P Key
Combination
You can use the
+P
key combination
to
quickly bring up the Second Screen menu.
You can also use the
Display Switch
button in the Control Center to access the menu
and select the appropriate attached display
mode.
You can also use the Fn
+F7 key combination to
quickly access the Second Screen menu in
Windows 8.

Figure C - 16
Second Screen
(Devices)
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Configuring an External Display In Windows
1.
2.
3.
4.

Attach your external display to the HDMI-Out port/mini display port, and turn it on.
Go to the Screen resolution control panel (see page 1 - 34) in the Desktop app.
Click the Detect button.
The computer will then detect any attached displays.

Figure C - 17
Screen Resolution
Multiple Displays
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Video Driver Controls
5.

You can configure the displays from the Multiple Displays menu.

Figure C - 18
Screen Resolution
Multiple Display
Options

C
• Duplicate these displays - Shows an exact copy of the main display desktop on
the other display(s)
• Extend these displays - Treats both connected displays as separate devices
• Show desktop only on 1/2 - Only one of your displays is used.

Attaching Other Displays - Devices (Charms Bar) C - 23
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NVIDIA Control
Panel
To access the GeForce..... control panel
from the desktop; rightclick the desktop, then
click NVIDIA Control
Panel.

NVIDIA Control Panel
(Model B Only)
More advanced video configuration options are provided in the NVIDIA Control
Panel tab.
1.
2.

Go to the Control Panel.
Double-click NVIDIA Control Panel (click to view the control panel in either Large
icons or Small icons if you are in Category view).

C
Figure C - 19
NVIDIA GeForce.....
Control Panel
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Video Driver Controls
The NVIDIA Control Panel provides additional video configuration controls and
tools which allow quick access to features such as image settings, 3D Settings and
video configuration.


Navigating the
Control Panel
Navigate through the
control panels in much
the same way as you
would a web page.
Click on the sub-heading tasks in the left
menu (and on the highlighted links) for information.
Use
the
buttons on the top left
to go back, forward
etc.

C
Figure C - 20
NVIDIA Control
Panel
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Display GPU
Activity Icon
Click to enable Display GPU Activity
Icon in the Notification Area to quickly
access the GPU Activity monitor from the
taskbar.

Optimus™ Customization Options
One of the most important aspects of Nvidia® Optimus™ technology is that it will
switch between the integrated GPU and discrete GPU seamlessly and automatically,
and does not require any input from the user. However customization options are offered for users who prefer to set their own parameters for GPU usage.
Context Menu
One of the quickest ways to choose which GPU to use for a particular application is
by using the “Run with graphics processor” in the context menu.
1.
2.

Go to the NVIDIA Control Panel (see page C - 24).
Click Desktop from the top menu and select Add “Run with graphics
processor” to Context Menu (it should have a tick alongside it).

C
Figure C - 21
NVIDIA Control
Panel - View
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3.
4.
5.
6.

Close the NVIDIA Control Panel.
Find the executable file icon of the application you want to run.
Right-click the icon and select Run with graphics processor from the context
menu.
Select either High-performance NVIDIA processor (dGPU) or Integrated
graphics (iGPU) to run the program with the selected GPU.


iGPU or dGPU
Note the NVIDIA control panel refers to
High-performance
NVIDIA
processor
(which is the discrete
GPU) and Integrated
graphics (which is the
integrated GPU).

Figure C - 22
Context Menu with
Run with graphics
processor

Right-click the application executable file

NVIDIA Control Panel C - 27
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Global Settings
Global settings allows you to set the preferred graphics processor for overall use.
Ideally this would be the iGPU for battery life, but this can be set to the dGPU if preferred.
1.
2.
3.
4.
5.

Go to the NVIDIA Control Panel (see page C - 24).
Click Manage 3D Settings (3D Settings) and select Global Settings (tab).
Select either Integrated graphics (iGPU) or High performance NVIDIA
Processor (dGPU) from the drop-down menu.
Click the Setting menu items to select any options required.
Click Apply to save the settings.

Figure C - 23
Global Settings
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Program Settings
Program settings allows you to make specific adjustments for installed applications.
1.
2.
3.
4.
5.
6.

Go to the NVIDIA Control Panel (see page C - 24).
Click Manage 3D Settings (3D Settings) and select Program Settings (tab).
Select a program to customize from the drop-down menu, or click Add to add
any program that does not appear in the menu.
Select the preferred graphics processor for the program from the drop-down
menu.
Click the Setting menu items to select any options required.
Click Apply to save the settings.

Figure C - 24
Program Settings
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Set PhysX® Configuration
NVIDIA® PhysX® is a physics engine that can use the GPU to accelerate game and
3D application performance. You can select the GeForce video card or CPU as a
PhysX® processor, or configure the computer to auto-select a PhysX® processor
(recommended default setting).
1.
2.
3.
4.

Go to NVIDIA Control Panel (see page C - 24).
Click Set PhysX configuration.
Click to Select a PhysX processor from the menu; Auto-select (recommended) is
the default setting.
Click Apply to save the settings.

Figure C - 25
Set PhysX®
Configuration
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HDMI Audio Configuration
HDMI (High-Definition Multimedia Interface) carries both audio and video signals.
In some cases it will be necessary to go to the Sound control panel and manually
configure the HDMI audio output as per the instructions below.
1.
2.
3.
4.

Go to the Control Panel.
Click Sound
(Hardware and Sound) and click/ Playback (tab)
Depending on your display, the playback device may be selected, however in some
cases you may need to select the audio device and click/tap Set Default (button).
Double-click the device to access the control panel tabs illustrated overleaf.


Volume Adjustment
The sound volume level
can be set using the volume control in the Settings menu in the
Charms Bar.

C
Figure C - 26
Sound - HDMI
Device (set Default)
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5.
6.

Adjust the HDMI settings from the control panel tabs.
Click/tap OK to close the Sound
control panel.

Figure C - 27
HDMI Device
Properties
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HDMI Notes
• Connect a device with HDMI support to the HDMI-Out port BEFORE attempting to play audio/video sources through the device.
• To play audio sources through your external display’s (TV or LCD) speakers
you will need to go to the audio configuration control panel on the display and
configure the audio input accordingly (see your display device manual).
HDMI Video Configuration
1.
2.
3.
4.

Connect an HDMI cable from the HDMI-Out port to your external display.
Configure your external display as per the instructions in “Attaching Other
Displays” on page C - 19.
Set up your external display (TV or LCD) for HDMI input (see your display device
manual).
You can now play video/audio sources through your external display.


Other Applications
If you are using a third
party application to
play DVDs etc. from
any attached DVD device, you will need to
consult the application’s documentation
to see the appropriate
audio
configuration
(the application must
support digital to analog translation).

C
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Appendix D: Specifications

Latest Specification Information
The specifications listed in this Appendix are correct at the time of going to press. Certain items (particularly processor types/
speeds and CD/DVD device types) may be changed, updated or delayed due to the manufacturer's release schedule. Check
with your distributor/supplier for details.
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Specifications
Processors

Memory

Video Adapter (For Model B Only)

Intel® Core™ i7-4500U processor
(22nm, 1.80GHz, DDR3L-1600MHz, 4MB
L3 cache, TDP: 15W)

Dual Channel DDR3L

For Model B Only:
Supports NVIDIA® Optimus
Switchable GPU Technology between
iGPU and dGPU

Intel® Core™ i5-4200U processor
(22nm, 1.60GHz, DDR3L-1600MHz, 3MB
L3 cache, TDP: 15W)
Intel® Core™ i3-4010U processor
(22nm, 1.70GHz, DDR3L-1600MHz, 3MB
L3 cache, TDP: 15W)

Display
14.0” / 35.56cm HD (1366 * 768) / HD+
(1600 * 900) / FHD (1920 * 1080), 16:9
3.2mm thick Backlit Panel
For Model C Only:
Multi Touch Screen

Two 204 Pin SO-DIMM Sockets
Supporting DDR3L 1600 MHz Memory
Modules (real operational frequency
depends on the FSB of the processor)
Memory Expandable up to 16GB
Compatible with 2GB, 4GB or 8GB Modules

Video Adapter (All Models)
Intel® HD Graphics
(GPU is Dependent on Processor):
Dynamic Frequency
Intel Dynamic Video Memory Technology
up to 1.7MB
Microsoft DirectX®11 Compatible
Intel HD Graphics 4400 (for i7-4500U,
i7-4200U & i3-4010U CPUs)
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NVIDIA® GeForce 745M Discrete GPU:
2GB DDR3L Video RAM
Supports PCIe * 4
Microsoft DirectX®11.1 Compatible
Supports HDMI™
NVIDIA PhysX™
GeForce CUDA™ Technology
NVIDIA® Optimus Technology

Storage
One Changeable 2.5" / 7.0mm (h) HDD/
SSD with SATA (Serial) Interface
mSATA SSD (Solid State Drive) with
SATA (Serial) Interface (Factory Option)

Specifications
Audio

Card Reader

High Definition Audio Interface
Built-In Microphone
2 * Built-In Speakers
Sound Blaster™ Cinema (for Model B
Only)

Embedded Push-Push Multi-In-1 Card
Reader
- MMC/ RS MMC
- SD/ Mini SD / SDHC/ SDXC
Note: Some of these cards require PC
adapters that are usually supplied with
the cards.

Keyboard & Pointing Device
Built-in Touchpad with Multi-Gesture
Functionality

Mini Card Slots

Isolated A4 Size Keyboard

Slot 1 for Half Size Mini-Card WLAN
Combo Module with PCIe & USB
Interfaces

Interface
Two USB 3.0 Ports
One HDMI-Out (High-Definition
Multimedia Interface) Port (with HDCP)
One Headphone-Out Jack
One Microphone-In Jack
One RJ-45 LAN Jack
One DC-In Jack

Slot 2 for Full Size Mini-Card 3G Module
with USB Interface
OR
Full Size Mini-Card SSD (Solid State
Drive) with SATA Interface

Communication
For All Models:
Built-In 10/100/1000Mb Base-TX
Ethernet LAN
1.0M HD Video Camera Module with
USB interface

For All Models:
UMTS/HSPA+ based 3G Module with
Full Size Mini-Card Interface (Factory
Option)
Quad-band GSM/GPRS (850 MHz, 900
MHz, 1800 MHz, 1900 MHz)
UMTS WCDMA FDD (2100 MHz)
Note that UMTS modes CAN NOT be
used in North America
For Models A & B Only:
(802.11b/g/n) Half Mini-Card PCIe WLAN
+ Bluetooth V4.0+LE Combo Module
(Factory Option)
(802.11b/g/n) Half Mini-Card PCIe WLAN
Module with PCIe Interface (Factory
Option)
For Model C Only:
Intel® Dual Band Wireless-AC 7260
(2*2 802.11 a/c) Half Mini-Card PCIe WLAN
+ Bluetooth Combo Module (Factory Option)
Intel® Dual Band Wireless-N 7260 (2*2
802.11 a/g/n) Half Mini-Card PCIe WLAN
+ Bluetooth Combo Module (Factory
Option)
See Over
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For Model C Only:
Intel® Dual Band Wireless-N 7260 (2*2
802.11 a/g/n) Half Mini-Card PCIe WLAN
Module (Factory Option)

BIOS

Environmental Spec

One 96Mb SPI Flash ROM
AMI BIOS

Power

Security

Full Range AC/DC Adapter
AC input 100 - 240V, 50 - 60Hz,
DC Output 19V, 3.42A (65 Watts)

Security (Kensington® Type) Lock Slot
BIOS Password
Trusted Platform Module 1.2 (Factory
Option)

Temperature
Operating:
Non-Operating:
Relative Humidity
Operating:
Non-Operating:

Battery
Features
Removable 4 Cell Smart Lithium Ion Battery
Pack 44.6WH

Power Management
Supports Wake on LAN
Supports Wake on USB
Supports Wake on RTC Alarm (AC Mode
Only)
Supports Wake on WLAN

LED Indicators

D

Power/Suspend, Battery, HDD/ODD,
Airplane Mode, Camera
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Painted Style (For some Model designs
in this series)
Intel® Rapid Start Technology
Intel® Smart Response Technology
(processor dependent)
Intel® Anti-Theft Technology
Intel® Identity Protection Technology
Intel® Smart Connect Technology

Operating System
Windows® 8 (64-bit)
Windows® 8.1 (64-bit)

5°C - 35°C
-20°C - 60°C
20% - 80%
10% - 90%

Dimensions & Weight
Models A & B:
340mm(w) * 240mm(d) * 21.0mm(h)
2.0kg with Battery
Model C:
340mm(w) * 240mm(d) * 22.8mm(h)
2.0kg with Battery

